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Adobe PostScript was first

developed in the early 1980s at

Xerox PARC by John Warnock

and Chuck Geschke, CEO and

president of Adobe. Not only

did PostScript give birth to

Adobe Systems, but it started a

revolution that continues to this

day. PostScript is the software

for describing to a printer the

appearance of a page, including

text, graphics, and scanned

images. Adobe works with more

than 70 industry-leading

manufacturers to produce more

than 300 output devices that

bear the Adobe PostScript mark

of excellence. PostScript Level 3

was announced in April of 1997.
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Feature Techniques
M A C  O S  /  W I N D O W S  /  U N I X

Understanding PostScript Error Messages

If a PostScript file fails to print because of an error, the ex-
perience can be frustrating, time-consuming, and, ulti-
mately, expensive. Because the printing systems that sup-
port the PostScript language are complex, their error mes-
sages can be varied and difficult to diagnose. With some
knowledge of the PostScript language and the environment
in which it operates, though, these experiences can be re-
duced or even eliminated. This appendix provides a basis
for understanding PostScript errors and ways to interpret
and correct them.

    
When you print a page on a desktop printer or a RIP (see
“What Is a RIP?” page 101) that supports the PostScript
language, the printer or RIP executes an electronic file that
is a representation of the page in PostScript code. More
accurately, the printer or RIP contains software called the
PostScript interpreter, which is responsible for executing
the PostScript file and creating a second representation of
the page (often called the raster image) that can be under-
stood by a printer engine. The engine then prints the raster
image on paper or film.

When the interpreter executes a PostScript file, the usual
result is that the corresponding page or pages are printed
by the printer engine. If there is something wrong with the
PostScript code in this file, however, the interpreter will
detect an error—a PostScript error. When such an error
occurs, the interpreter executes special code, called an er-
ror handler, designed to address that particular error. The
error handler records information in the RIP’s memory
about the error and then executes a command to stop pro-
cessing the file.

At this point, the PostScript code in the file may ignore
the command to stop processing so that the interpreter may
continue executing the file. For example, a file’s request for
duplex (two-sided) printing on paper will likely cause an
error if it’s sent to a printer that prints on only one side of
the paper. If so, the internal error handler for that error
executes the command to stop the job. But the PostScript
file may ignore the command to stop as well as the request
for duplex printing (the source of the error). Although the
job will not fail in this case, it will print only single-sided
pages. If the PostScript code does not ignore the command
to stop, the interpreter processes the information recorded
earlier by the internal error handler, which usually produces
a message that looks like this:

%%[ Error: <error name>; OffendingCommand:
<command name> ]%%

%%[ Flushing: rest of job (to end-of-file)
will be ignored ]%%

The first line shows the name of the error as well as the
name of the PostScript command that caused the error. The
second line states that the rest of the job will not be pro-
cessed. (This particular error message is very useful, al-
though you may not always be able to see it. See “Display-
ing Error Messages,” page 102, for information on how to
find error messages.) The interpreter will then stop execut-
ing the file.

The RIP may create other error messages that look like
the one shown above. If the messages have a similar format
but do not contain the words Error and OffendingCom-
mand, however, they are very likely not PostScript errors.
For example, you may see a message containing the label
PrinterError, such as:

%%[ PrinterError: Media jam ]%%
This type of message does not represent an error in the
PostScript file detected by the interpreter. It represents a
different type of problem that was detected by some other
part of the system, in this case by the printer engine.

  
Although you need to take some action to correct a Post-
Script error, you may not understand what the error is when
you see the message corresponding to that error.

%%[ Error: limitcheck; OffendingCommand:
sethalftone ]%%

If you see this message, for instance, you know that an er-
ror called limitcheck occurred when a command called
sethalftone was executed in the file, but this message doesn’t
tell you much about the source of the problem. In some
cases, you may get a clue from the name of the error or
command involved. In this example, you might guess that
the error was produced by some limit that was reached while
attempting to set up a halftone screen.
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You can make more educated guesses by learning about
the types of commands and errors contained in the Post-
Script language. The PostScript Language Reference Manual
(second edition) is the official specification for the Post-
Script language. It contains descriptions of all of the stan-
dard commands and errors contained in Level 2 of the
PostScript language. The standard commands are com-
monly referred to as operators. Section 8.1, “Operator Sum-
mary,” groups all of the operators in the PostScript lan-
guage into twenty-four categories. It also contains a brief
summary of the thirty possible PostScript errors.

When analyzing an error message, look first at the of-
fending command to determine what type of operation
failed. Then look at the name of the error to determine
what kind of failure occurred. In both steps, use Section
8.1 as a guide. The error name alone is meaningless with-
out also knowing the offending command. For example, a
limitcheck error message means that some limit in the RIP’s
design was exceeded; by itself, however, a limitcheck error
message tells you nothing about which limit or even what
kind of limit was exceeded.
The offending command.
The OffendingCommand statement identifies which Post-
Script operator failed. Operators may be divided into two
groups: those that influence the appearance of a page and
those that do not. In particular, operators in the first group
influence the appearance of the three types of objects sup-
ported in the PostScript language: text, graphics, and im-
ages (images include rasterized artwork that has been gen-
erated digitally or scanned to capture pixel data). The dis-
tinction between the two groups is important: You may be
 : 

Graphics State, 
Device-Independent

Graphics State, 
Device-Dependent

Path Construction

Painting

Form and Pattern

Character and Font

Device Setup

Used to control how objects are  painted; results 
should not vary from one type of output-device engine 
to another

Used to control how objects are painted; results 
usually vary from one type of output-device engine 
to another

Used to create graphics such as polygons and curves

Used to paint graphics and images

Used to generate repeatable forms and patterns

Used to set up printing attributes

Used to manipulate fonts and parts of fonts, such as  
characters

   
able to correct errors resulting from operators in the first
group by modifying the document from within the appli-
cation that you used to create it. Operators in the second
group, however, are used for the programming aspects of a
PostScript file and require a great deal of experience with
the PostScript language to understand and troubleshoot.

The first group of operators can be broken down fur-
ther using the categories in Section 8.1 of the PostScript
Language Reference Manual, which are described in Table
1: Graphics State, Device-Independent; Graphics State,
Device-Dependent; Path Construction; Painting; Form and
Pattern; Device Setup; and Character and Font. The large
number of operators represented by these seven categories
may be overwhelming, but bear in mind that within each
category, some operators are seldom used. For example, the
Painting operator f i l l occurs often because it is used to
paint graphics; however, the Painting operator ueof i l l is
rarely used because it is more specialized.

When you see an operator name in an error message’s
OffendingCommand statement, find its category in Sec-
tion 8.1. This will help you identify the type of operation
that produced the error. For example, the show operator is
in the Character and Font category; therefore, if you see an
error whose offending command is the show operator, you
should suspect that there is a problem with the text in the
PostScript file. Table 1 (page 102) lists the seven operator
categories, along with their descriptions and common ex-
amples.

You may see some commands in error messages that
you will not find in the PostScript Language Reference
Manual because they are not standard PostScript com-
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setcolor
setlinewidth

sethalftone
setflat

lineto
curveto
arc

stroke
fill
image

setpattern
execform

findfont
show

setpagedevice

Establishes the color for an object to be painted
Establishes the thickness of painted lines

Establishes a requested halftone screen 
Establishes the flatness of curves

Draws a line 
Draws a curve
Draws part or all of a circle

Paints the outline of graphics
Paints the interior of graphics
Paints images

Establishes a pattern
Paints a form

Looks for and loads a requested font
Paints a character or group of characters

Installs requested device features
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 :   

A requested feature setting cannot be satisfied; often 
accompanied by an extra ErrorInfo field in the error 
message indicating the requested feature.

There is no more room in PostScript data structures 
called dictionaries; this problem is more common with 
PostScript Level  than with Level . 

An attempt was made to put an object into a read-only 
data structure.

There was an attempt to install a malformed or an 
improperly licensed font in the RIP’s memory.

There is a programming problem with memory  
management.

An input/output error occurred while the RIP was  
processing a file; the file in question could be the actual 
job or another file referenced by the job file.

An implementation limit was exceeded.

configurationerror

dictfull

invalidaccess

invalidfont

invalidrestore

limitcheck

ioerror

The requested font was not supplied by the RIP or was 
not within the PostScript file. (This error message is 
formatted differently; it has no offending command.)

<fontname> not 
found, using 
Courier.

Do not request the feature from the printer driver, use 
a different printer support file, or configure the RIP to 
support the feature.

These operators store objects in dictionaries; error 
requires advanced debugging.

These operators store objects in various PostScript data 
structures; error requires advanced debugging.

Replace or reinstall the font on the RIP and/or 
computer.

There is likely a problem with the printer driver; 
requires advanced debugging.

A graphic is too complex (this occurs very  rarely  when 
using PostScript Level ); increase flatness, split paths, 
simplify the graphic, or lower the printer engine’s 
resolution. 

The internal representation of the requested halftone 
screen is too large or too small; consult your RIP 
vendor.

The image is too large, its resolution is too high, or it 
cannot be rotated. Reduce the size or resolution, rotate 
the image at a different angle, or rotate it in an image 
editing application such as Adobe Photoshop.

The amount of data supplied is incorrect; scan, edit, or 
import the image again.

These characters may indicate a problem with the 
communications link; move or replace the 
communications line, check communications settings, 
disable spoolers, or run the job again.

setpagedevice

store, put, def

store, put, def

findfont, definefont, 
selectfont

restore

show, fill, stroke, 
clip, other painting 
operators

image

sethalftone

image, colorimage

Random characters

Not applicable Download the missing font to the RIP, include it in the 
document, or choose a different font.
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mands. This situation is much more common in products
that support only Level 1 of the PostScript language than
in those that support Level 2 as well (see “PostScript Level
2,” page 104).
The error name.
After identifying the offending command in the error mes-
sage, note the error name that was also reported in the
message. The more common errors and their meanings are
listed in Table 2 (pages 104-105), along with examples of
offending commands and common problems and solutions
for those combinations of errors and offending commands.
Some of the examples are more complicated programming
errors that require advanced debugging techniques and
knowledge of the PostScript language to evaluate and cor-
rect. In such a case, you should call a local expert, the ap-
plication vendor, or your RIP vendor for assistance.

You will find that the solutions offered in Table 2 do not
always apply to the errors that you experience. There are
too many possible errors— offending command combina-
tions, circumstances that produce errors —and possible so-
lutions to list in a single table. Instead, this information is
intended to give you an idea of the usual meanings of com-
mon errors and how they vary.

To learn more about operators and errors, see Section
8.2, “Operator Details,” of the PostScript Language Refer-
ence Manual; the rest of the manual describes the prin-
ciples of operation regarding PostScript operators and er-
rors. There are also a number of books and classes that dis-
cuss the PostScript language in more practical terms (see
“Suggested Reading” and “Training Courses and Seminars,”
page 108).

  
After the interpreter creates an error message, several things
can happen to it, depending on the printer or RIP you are
using. The message, perhaps in a different format than de-
scribed earlier, may be recorded somewhere in the RIP, or it
could be sent back to the computer that sent it to the RIP.
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A time limit for an operation has been exceeded. A time-out threshold is set too low or there is a  
communications problem. Use administration software 
or the printer driver to reset the time-out value on the 
RIP, or try a different driver.

The operator expected a certain type of value on the  
operand stack, but the wrong type was provided 
instead.

May be a printer driver problem or interference from a 
separate utility; requires advanced debugging.

This could indicate a problem with the communications 
link or with the leftover data in the job; try a different 
communications line or printer driver. This problem 
may also occur if a PostScript file is saved, transferred to 
a different computer platform, and downloaded from 
that computer; try saving the file in ASCII or Text Only 
rather than binary format.

The name specified in the OffendingCommand is not 
known to the RIP.

This is not a PostScript operator; it indicates that the 
required PostScript code has not been included in a 
PostScript file saved on the Macintosh. Resave the file. 

The job contains a nonstandard operator that is not 
recognized by the RIP; check the driver settings or select 
a different printer support file.

Too much data for an image may have been supplied; 
scan, edit, or import the image again.

The RIP has run out of PostScript virtual memory 
(VM) during the job.

Reboot the RIP to clear its memory;  this error should 
be very rare when using PostScript Level .

rangecheck setpapertray 
(Level )

Several  operators

stackunderflow

The requested paper tray does not exist; request a 
different tray from the printer driver. 

Requires advanced debugging

May indicate a printer driver problem or interference 
from a separate utility; requires advanced debugging.

A value provided to the operator was outside the  
acceptable range.

The operator expected one or more values to be  
available on the operand stack, but there were none.

stackoverflow May indicate a printer driver problem or interference 
from a separate utility; requires advanced debugging.

This is a programming problem concerning the filling 
up of an internal data structure called the operand 
stack.

Several operators

timeout

typecheck

Several operators

Several operators

undefined md

Several operators

Random characters

VMerror

Several  operators

Random or no characters

Several operators
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If your RIP does not record messages or is unable to
send them to an attached computer, the messages will be
lost. In this case, it is best to use an error handler utility.
Error handler utilities are PostScript files that change the
way error messages are processed and displayed by the in-
terpreter. For example, they may print the error informa-
tion at the RIP or write it to the RIP’s disk so that it may be
read later. Some error handler utilities also provide more
information than just the error message, but this additional
information typically requires in-depth knowledge of the
PostScript language. Contact your RIP vendor for infor-
mation on available error handler utilities. Adobe Systems
also provides a simple error handler utility via modem or
the Internet (see “Accessing Adobe Files,” page 103).

Even if the RIP can send error messages back to your
computer, you may not see the error message at all or it
may flash by too quickly on your computer’s display to be
read or understood. In this case, the printer driver on your
computer is ignoring or intercepting messages sent back
from a RIP. (Examples of printer drivers include Apple
Computer’s LaserWriter driver, Microsoft’s PSCRIPT™
driver, and Adobe Systems’ PSPrinter™ and ADOBEPS™
drivers for the Macintosh and Windows platforms, respec-
tively.)

Further, if the printer driver detects that the message
represents an error, it may post an uninformative message
such as -8133, which indicates that a PostScript error has
occurred. Be aware that not all generic error messages in-
dicate a PostScript error. For example, the messages -4100
or The job is OK but can’t be printed. on the Macintosh
may indicate a problem in the communications link be-
tween the Macintosh and the RIP.

You can use an error handler utility in this case, but this
is not always the best choice. An error handler utility that
instructs the RIP to print the error information on paper
or film, for instance, could be an expensive waste of media.
A better method is to look for an option to display error
messages when you print. The PSPrinter and LaserWriter
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8.0 printer drivers (from Adobe Systems and Apple Com-
puter, respectively) both provide this option.

If this feature is not available to you, the next best
method is to save the PostScript file on your computer’s
hard disk drive and download it separately to the RIP. Look
for an option to save the PostScript file when you print.
After saving the file, send it to the RIP using a downloader
utility. (Examples of downloader utilities are font down-
loader software, LaserTalk™, and SendPS™, all of which
are available from Adobe Systems; your RIP vendor may
also offer downloader utilities.)

Typically, downloader utilities either show you the er-
ror message on-screen after sending the file or write any
information returned by the RIP to a “log file” on your
computer’s hard disk drive. Alternatively, if your error han-
dler utility provides additional information from the RIP
with the error message and does not print on media, install
it and then download the saved PostScript file. This allows
you to see the more complete information returned by the
error handler utility.

Follow these steps to help you determine which method to
use to display complete error messages:

1. If the RIP can record or display error messages, consult
the RIP documentation on how to read them. If not, go
to step 2.

2. If the RIP is unable to send messages back to your com-
puter, use an error handler utility. If it can send mes-
sages back, go to step 3.

3. If you are able to see complete error messages when you
print, begin using them. If not, go to step 4.

4. If your printer driver has an option to display complete
error messages, enable this option when you print. If
not, go to step 5.

5. If your printer driver has an option to save PostScript
files, save the file, then use a downloader utility to send
the file to the RIP.

6. Finally, try running the PostScript file through the Adobe
Acrobat Distiller. If the Distiller detects the same error,
you should be able to see what that error is.

If none of these methods works, you will need to use more
advanced techniques. Consult with a local expert or con-
tact your RIP vendor for assistance.

   
In order to correct a PostScript error, you first need to know
at which point in the printing process it was introduced.
Although printing a document is a complex operation that
varies slightly from one printing environment to another,
generally there is a common sequence of steps. If you be-
come familiar with these steps, you will be better able to
isolate the cause of the errors you encounter. The follow-
ing list describes each step in the printing process, along
with common problems associated with it and suggested
solutions.
1. You compose a document on your computer using an

application. The application uses its own graphics lan-
guage to represent the document on your monitor. The
document may also include files imported from other
applications. If there is a problematic object in this docu-
ment or an error in one of the imported files, remove
or modify the offending object or imported file.

2. When you print the document, you select the destina-
tion RIP as well as various settings for printing the docu-
ment on that RIP, such as paper size, hardware resolu-
tion, or flatness. If you selected settings that are inap-
propriate for the RIP, try selecting different ones.

3. The printer driver then converts the document into a
PostScript file. The driver translates the representation
of the document from the application’s graphics lan-
guage into the PostScript language. If the PostScript code
created by the printer driver is faulty, the translation
will produce an error. Try a different printer driver or
try modifying the document from within the applica-
tion.

4. Some printer drivers add information to the PostScript
code, such as details about fonts, images, and other re-
sources required by a document. Such information can
be formatted according to the Document Structuring
Conventions (DSC) described in the PostScript Lan-
guage Reference Manual or the Open Prepress Inter-
face (OPI) specification. If there is a mistake in the added
information, a problem in the PostScript code may be
introduced later if a spooler is attached to the RIP. Try
using a different driver, changing the fonts, or changing
the structure of the document (by moving or deleting
pages, for example).

5. The printer driver may insert extra PostScript code into
the file (see “Sending the Right File,” this page) that re-
quests specific features of the destination RIP. Some
printer drivers obtain this code from printer support
files, such as PostScript Printer Description (PPD) files
from Adobe Systems (see “Customizing a PPD File,” page
108). These support files contain product-specific code
so that the printer drivers don’t have to include it. If
you or the printer driver chooses the wrong printer sup-
port file for the destination RIP, go back and select the
appropriate printer support file for the RIP. If the infor-
mation in the printer support file is incorrect, contact
your RIP vendor or try using a printer support file for a
very similar RIP.

6. The PostScript file is sent or transferred to the RIP, usu-
ally by the printer driver. If there is a problem with the
way that the file is sent to the RIP, either in the physical
connection or in the software that is sending the file,
try a different way of sending the file. For example, try a
different cable, using a different type of communica-
tions link, or using the same link but a different printer
driver, downloader, or file transfer software.

7. If a spooler or OPI server is on the network or part of
the RIP, the spooler or server intercepts the file. (A
spooler is software that coordinates the delivery of files
to a RIP.) Some spoolers and servers modify the file ac-
cording to the DSC or OPI information in the file be-
fore passing it on to the PostScript interpreter within
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the RIP. If the DSC or OPI information is incorrect or if
the spooler handles the information incorrectly, an er-
ror will result. Disable the spooler if possible, or check
that the resources required by the file are available at
the RIP.

8. Finally, the interpreter executes the file—this is when
errors are actually detected. Problems within the inter-
preter itself are less common than errors introduced in
the previous steps. Some utilities, such as those for color
calibration, make subtle changes to the interpreter’s
operation that can interfere with the proper operation
of the interpreter. If there is a problem in the interpreter
or if a utility is interfering, try either using a different
RIP or restarting the RIP without using specialized utili-
ties. If this does not help, contact your RIP vendor to
report the problem.

If all else fails, one final solution that you can try is to save
the PostScript file, modify it directly, and download it to
the RIP. This requires explicit knowledge of the PostScript
language and of DSC, however. Alternatively, you can con-
tact your RIP vendor for assistance.

     
Note that one common action in the suggested solutions is
to replace, remove, or otherwise change a particular part in
the process, such as the printer driver, printer support file,
or spooler. The best way to find the cause of an error is to
isolate it by systematically changing one part of the process
at a time and then observing whether the error still occurs.
If you make a change and the problem disappears, you have
located the cause of the problem and solved it as well; oth-
erwise, try changing another part of the process.

Replacing the printer driver is a common change, since
the driver is involved in several of the steps in the printing
process. If you try a different driver, you are sending differ-
ent PostScript code for the same document. (Some appli-
cations, such as Adobe Photoshop, Adobe Illustrator, and
QuarkXPress, generate their own PostScript code, so chang-
ing the driver may not have an effect in these cases.) If the
error persists, then you need to look at the other parts of
the process, such as modifying the file from within the ap-
plication or changing the way the file is transferred to the
RIP.

If you modify the file in the application, you can use a
similarly systematic approach by replacing, removing, or
modifying pages or objects on the page. Again, the error
information may guide you in determining which objects
to change.

There are several ways to change the method for trans-
ferring a file to the RIP. You can try different physical con-
nections, such as LocalTalk® or EtherTalk® (both from Apple
Computer) or serial or parallel cables. Or you can save a
PostScript file using the printer driver and then send it to the
RIP separately with a downloader utility. In this case, you
are using the downloader utility software to transfer the file
to the RIP; if the error disappears, you know it had to do
with the way the printer driver transferred the file.
When you save a PostScript file using a printer driver,
however, you may introduce some new problems. Because
the driver adds device-dependent code to the file, it may
not be appropriate to send the file to another type of RIP;
either the file will fail or you will not get the printing fea-
tures you requested. Also, if you transfer a saved PostScript
file from a Windows or DOS machine to a Macintosh, there
may be nonprinting characters (also called binary charac-
ters) within the file that will cause an undefined error when
the file is downloaded to the RIP. In general, files with bi-
nary characters are much more difficult to transfer from
one computer platform to another. It’s safest to save files in
ASCII text format rather than binary format.

Another method for transferring the PostScript file is
to store the file on the RIP’s internal disk, if it has one, and
run it from there. This is similar to downloading and stor-
ing a font to the RIP’s internal disk. When you run the file
from the RIP’s disk, you no longer need to send the file to
print it, which effectively removes the communications step
from the printing process. (Note, however, that if the file
had binary characters in it when you stored it on the RIP’s
disk, those characters may have been lost if you used a se-
rial or parallel connection.)

Some downloader utilities allow you to store a PostScript
file to the RIP’s internal disk. If one is not available, use a
text editor (in ASCII format) to add the following PostScript
code to the beginning of a PostScript file:

%!
/rf currentfile def
/wf (myfile.ps) (w) file def
/str 65535 string def
 //rf //str readstring
 //wf 3 -1 roll writestring
 not {exit} if
} bind loop

You can change the name of the file by replacing myfile.ps
in the code with your file name (retain the parentheses).
It’s best to keep the name simple and to avoid using spaces
or nonalphanumeric characters. You can then send this new
file to the RIP using a downloader utility. If there are no
problems, the PostScript file will now be stored on the RIP’s
internal disk. Next, from within the text editor, create an-
other PostScript file that contains only this simple code:

%!
(myfile.ps) run

Again, substitute the placeholder myfile.ps with the name of
the file you stored previously on the RIP’s internal disk. Save
(also in ASCII format) and download this simple file to the
RIP. The file myfile.ps will be executed. You can send this file
as many times as you want to run myfile.ps. If the error per-
sists, then the source of the problem is not in the communi-
cations line or the way that the printer driver sent the file to
the RIP. Once you have finished testing for the error’s source,
you must delete the myfile.ps file; to do so, create and down-
load another PostScript file to the RIP that contains this code:

%!
(myfile.ps) deletefile
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Your RIP vendor may have utilities or methods available
for performing these kinds of operations with PostScript
files. For example, on some software-based RIPs that run
on workstations, it may be possible to store a PostScript
file on the workstation’s file system so that it can be ex-
ecuted by the RIP.

This systematic approach can be time-consuming, since
the printing process has so many parts and steps. Bear in
mind, however, that the PostScript error message will of-
ten provide clues about the type of operation that failed
and how it failed. For example, if you see an ioerror mes-
sage with random characters rather than an operator name
as the offending command, you should suspect a problem
with the communications link to the RIP. But if you see an
ioerror message associated with the image operator (related
to a scanned image), you should either suspect the com-
munications link or the application that you used to create
and save the scanned image.

With time and experience, you will discover that intui-
tive hunches play a part in determining the causes of
PostScript errors. Yet even when you are able to make such
intuitive leaps, it will always be a good idea to return to
basic principles: Know the steps in the printing process,
know how to display the complete error message, know how
to interpret the elements of the error message, and know
that successful troubleshooting requires systematically iso-
lating possible sources of the problem.
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1240
[, Feature Techniques, M|W|U, Issue/Solution, High, 8156]
Customizing a PPD File

A PostScript Printer Description (PPD) file—a printer sup-
port file in ASCII text format created by Adobe Systems or
one of its original equipment manufacturers (OEMs)—de-
scribes the specifications and features of a specific Post-Script
printing device in its original manufactured state. Applications
such as Adobe Separator and PageMaker, as well as printer
drivers from Adobe Systems and Apple Computer, use PPD
files, which may be distributed by the application vendor or
OEM. PPD files allow the user to select settings for different
features, such as paper sizes, tray options, halftone screens, and
output resolutions. Sometimes you may need to add to or
modify a PPD file for a particular printing environment. This
section—which is addressed primarily to prepress operators—
discusses common ways of customizing PPD files.

In general, modifying a PPD file requires knowledge of
the PPD format and often of the PostScript language itself.
Although neither Adobe Systems nor its OEMs support
PPD file customization, with careful attention to detail, it
can be done successfully.

 
Changes can be made to a PPD file in two ways: by editing
the PPD file directly with a text editor, or by creating and
editing a separate PPD file, called an editable customization
file, that refers to the original PPD file. If you edit the PPD
file, save a copy of the original and edit the copy, not the
original. Use any text editor to modify or create the PPD
file and always save the file in Text Only or ASCII format.

To create an editable customization file, create a new
file in a text editor and type the following line:

*Include: "filename"
Replace filename (keep the quotes) with the name of the

original PPD file that is to be customized. Add the custom
PPD entries you want before this line so it will override the
information in the original PPD file. The custom PPD en-
tries must conform to the PPD specifications. Save the
customization file with a unique name that represents the
changes you made or the particular device for which you
made those changes (for example, MyPrntr.PPD). The .PPD
extension (it is not case-sensitive) should be preserved be-
cause many applications and print managers search for files
with that extension. Store both the original PPD file and
the customization file in the same location.

Whenever possible, use the editable customization file
method rather than editing a PPD file directly. There are
several advantages to using an editable customization file
over modifying the PPD file. First, the editable custom-
ization file method allows you to isolate errors more easily.
Second, the original PPD files are still supported by Adobe
Systems and its OEMs because they remain unchanged.
Third, you can create a naming convention for the editable
customization files that will make it easy to track future
modifications. The disadvantage of using an editable cust-
omization file is that you must know the PPD file speci-
fications in order to make the correct entries.
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The only time you should edit the original PPD file is
when you wish to make a small number of simple changes.
In general, if you are making several customizations, you
should use the editable customization file method instead.


This section provides some examples of PPD file custom-
izations.
Editing halftone screen information.
The ColorSepScreenAngle and ColorSepScreenFreq entries
in either an original PPD or a customization file correspond
to a particular halftone screen angle and frequency for each
process and custom color, usually at a certain output reso-
lution. Although you may select a 132-lpi screen frequency
and a 2540-dpi output resolution in the dialog boxes of an
application such as Adobe Separator, the actual settings may
not represent an exact 132-lpi screen. To set your own cus-
tom screen frequency and angle, follow these steps.
1. Search for the ColorSepScreenAngle and ColorSep-

ScreenFreq entries in the PPD file (they are usually near
the end).

2. Locate the group of lines representing the screen fre-
quency and output resolution combination (in lpi and
dpi, respectively) you wish to modify (132/2540 in this
example). You will find lines of code similar to these:
*% For 132 lpi / 2540 dpi
*ColorSepScreenAngle
ProcessBlack.132lpi.2540dpi/132 lpi / 2540
dpi: "45.0"

*ColorSepScreenAngle
CustomColor.132lpi.2540dpi/132 lpi / 2540
dpi: "45.0"

*ColorSepScreenAngle
ProcessCyan.132lpi.2540dpi/132 lpi / 2540
dpi: "18.4349"

*ColorSepScreenAngle
ProcessMagenta.132lpi.2540dpi/132 lpi /
2540 dpi: "71.565"

*ColorSepScreenAngle
ProcessYellow.132lpi.2540dpi/132 lpi / 2540
dpi: "0.0"

*ColorSepScreenFreq
ProcessBlack.132lpi.2540dpi/132 lpi / 2540
dpi: "119.737"

*ColorSepScreenFreq
CustomColor.132lpi.2540dpi/132 lpi / 2540
dpi: "119.737"

*ColorSepScreenFreq
ProcessCyan.132lpi.2540dpi/132 lpi / 2540
dpi: "133.871"

*ColorSepScreenFreq
ProcessMagenta.132lpi.2540dpi/132 lpi /
2540 dpi: "133.871"

*ColorSepScreenFreq
ProcessYellow.132lpi.2540dpi/132 lpi / 2540
dpi: "127.0"
3. At the end of each ColorSepScreenAngle line, edit the
value within the quotation marks. This will change the
angle of the screen used to create the halftone. These
numbers must contain a decimal point, so follow each
whole number with a decimal point and a zero. For ex-
ample, enter 45 degrees as "45.0" (include quotation
marks). If you are using the customization file method,
copy these entries and place them in the customization
file before the line containing *Include. Then edit the
values in the customization file.

4. At the end of each ColorSepScreenFreq line, edit the
value within the quotation marks. This will change the
screen frequency used to create the halftone. These num-
bers must also have a decimal point, so follow each whole
number with a decimal point and a zero. For example,
enter 127 degrees as "127.0" (include quotation marks).

   
Applications and drivers use translation strings to describe
some menu items. Translation strings translate potentially
cryptic PPD file entries into easily identifiable names or
phrases, even in natural programming languages. To iden-
tify a translation string in a PPD file, look for a phrase pre-
ceded by a solidus (/) and followed by a colon (:). By edit-
ing these strings, you can use names that are more useful to
you than the printer vendor’s names.

For example, many imagesetter PPDs have a paper-size
selection called Letter.Transverse, for letter-sized paper that
is fed into the printer by its long edge. It may be more in-
tuitive to be able to select the Long-edge-feed Letter paper
size than it is to select the Letter.Transverse size in the ap-
propriate dialog box. You can customize the PPD file to
change the name of this paper size.

The latest drivers from Adobe Systems and Apple Com-
puter use the *PageSize entries in the PPD file to display
the names of the available paper sizes in the appropriate
dialog box. When the entry shown below exists, it causes
the printer driver to display Letter.Transverse, since there
is no translation string. (In a PPD file, these entries are
placed with other *PageSize entries; in a customization file,
they are placed above the line that contains *Include.)

*PageSize Letter.Transverse: "<PostScript
language code>"

Change the menu item by adding the following translation
string :

*PageSize Letter.Transverse/Long-edge-feed
Letter: "<PostScript language code>"

In this case, as a result of this new entry, the name of this
paper size will now be displayed as Long-edge-feed Letter
the next time you elect the same PPD file. Do not change
the PostScript language code between the quotes.
Changing the nickname of your printer.
There may be times when you’ll need to identify a PPD file
by the function of the printer it represents, rather than the
name of the product. The PSPrinter driver from Adobe
Systems, for example, is able to display an alternate name
for a PPD file when you select the printer in the Chooser
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on a Macintosh. Changing the *NickName entry in the PPD
file changes this alternate name.

First, find the *NickName entry, which is usually near
the beginning of the PPD file. It will look something like
this:

*NickName: "ACME Color Printer 1000
v2013.114"

You may change the nickname to something more useful
to you by changing the *NickName statement to read:

*NickName: "ACME Color Proofer"
The new nickname should be no longer than thirty-one
characters. f it is longer, add this entry: ShortNickName:
"<desired name>"

[All, Feature Techniques, M|W|U, Issue/Solution, Medium, 2477]

Adding Fonts to a Custom Printer
File Using a Text Editor

Custom printer files supplement PPD (PostScript Printer
Description) files, allowing printer information to be cus-
tomized for a particular printer (e.g., resident fonts, paper
sizes, virtual memory).

The External Font Information section in the selected
PPD or custom printer file indicates what fonts are installed
in the printer’s hard drive. From this list of fonts, applica-
tions that read PPD files determine what fonts to down-
load. Most PPD files list fonts in the printer’s ROM only.
The advantages of listing all fonts at the printer will de-
pend on your work flow and how many fonts are always
installed on the printer’s hard drive. Listing fonts in the
printer’s RAM is not recommended, as those fonts are de-
leted from memory when the printer is reset.

To add fonts available at the printer to a custom printer
file using a text editor:

1. Retrieve a list of PostScript font names available at the
printer. For instructions, see “Retrieving List of Post-
Script Font Names.”

2. Open the custom printer file in a text editor that can
save in text-only format (e.g., Microsoft Word, Teach-
Text, MS-DOS Editor).
note: Some text editors (e.g., Microsoft Write, Notepad)
add invisible characters (e.g., end-of-file, line feed) to
the file that prevent the PPD file from being parsed.

3. Before the “*Include” line, add the printer fonts using
the syntax:
*Font fontname: encoding “(version)” charset
status

For example, ROM resident fonts:
*Font Courier: Standard “(001.004)” Standard
ROM

*Font Symbol: Special “(001.003)” Special
ROM

For example, fonts residing on the printer’s
hard disk:

*Font Palatino-Bold: Standard “(001.002)”
Standard Disk

*Font Palatino-BoldItalic: Standard
“(001.002)” Standard Disk
*Font Palatino-Italic: Standard “(001.002)”
Standard Disk

*Font Palatino-Roman: Standard “(001.001)”
Standard Disk

*Font MinionMM-Ep: Expert “(001.000)” Expert
Disk

*Font MinionMM-It: Standard “(001.000)”
Standard Disk

*Font AGaramondAlt-Italic: Special
“(001.001)” Special Disk

*Font AGaramondAlt-Regular: Special
“(001.001)” Special Disk

note: The encoding, version, charset, and status are not
used by most applications (e.g., Adobe PageMaker).
Aldus TrapWise requires the correct font encoding, ver-
sion, charset, and status. If the custom printer file is used
only in PageMaker or Aldus PrePrint, the only infor-
mation required after the PostScript font name is “Stan-
dard” for encoding, “001.000” for version, “Standard”
for charset, and “Disk” or “ROM” for status. For ex-
ample:
*Font Palatino-Bold: Standard “(001.000)”
Standard Disk

4. Save the custom printer file in text-only format in the
Printer Descriptions folder (Macintosh) or in the ALD-
US\USENGLSH\PPD4 subdirectory (Windows).

       


Create a Font catalog using Apple LaserWriter 8.0 Utility
v 7.4.1:

1. Use Apple LaserWriter 8.0 Utility v 7.4.1 or later to print
a Font catalog to disk.

2. Open the file in a text editor, and search for the PostScript
font names in parentheses (e.g., Helvetica-ExtraCom-
pressed) listed in the section “Fonts on printer.”
or: Use a PostScript file downloading utility (e.g., Adobe
Font Downloader 5.04) to print or display a list of
PostScript font names.
note: PostScript font names displayed by Adobe Font
Downloader 5.04 cannot be copied from the displayed
list.

or: Download a PostScript routine to query for fonts at
the printer, and return a list of these fonts in a text file:
1. Open a new file in a text editor that can save in text-

only format.
2. Type the following PostScript code (Color Central User

Manual, p. 71):
statusdict begin save
/SC 100 string def
FontDirectory{pop = flush}forall
(fonts/*){dup length 6 sub 6 exch
getinterval = flush} SC filenameforall

restore
3. Save in text-only format.
4. Download the PostScript routine file using a utility able
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to return a text or log file (e.g., Apple LaserWriter 8.0
Utility v 7.4.1). The log file returned will contain the
every font name resident in the printer’s RIP (i.e., ROM,
RAM, hard drive).
or: Copy the FontName line in the PostScript font’s
AFM file, included with PostScript fonts.
or: Use ResEdit to open the printer font and retrieve
the font name from the POST resource number 501.
or: Use the Update PPD Addition or PPDShell.ps Post-
Script routine file included with Adobe PageMaker 5.0x
to query and list available fonts at the printer in the gen-
erated custom printer file.
note: The fonts listed in the custom printer file gener-
ated by the Update PPD Addition or “PPDShell.ps”
PostScript routine file can be copied into other custom
printer files.

       
Use a PostScript file downloading utility to print a list of
PostScript font names.
or: Copy the FontName line in the PostScript font’s AFM
file, included with PostScript fonts.

[All, Feature Techniques, M|W|U, Issue/Solution, Medium, 2478]

Creating Smooth and Efficient
Gradations or Blends for PostScript

PostScript creates a graduated effect digitally by generating
a series of halftone bands. Each band is a different shade or
tint; the series of tint bands create the illusion of a grada-
tion. The thinner the tint bands, the smoother the grada-
tion will appear. Thick bands create a gradation that ap-
pears “banded.”

It is possible to calculate the size of tint bands in a gra-
dation (i.e., gradient fill, radial fill, or blend) to predeter-
mine banding and ensure efficient blends for PostScript
output. These calculations aid in creating gradations with
the optimum number of steps to prevent noticeable band-
ing while decreasing imaging times. As a general guideline,
gradations with tint bands less than 3 points wide appear
smooth; tint bands 3 points or wider appear banded.

When creating blends, do not add extra blend steps to
create a smoother effect. The number of tints produced is
related to the variables listed below. Specifying more blend
steps than the number of available tints adds extra infor-
mation that the printer cannot use but still has to process,
making the print time longer with no increase in quality.

The following information is needed to calculate tint band
widths:

• The printer resolution in dots per inch (dpi).
• The screen frequency in lines per inch (lpi).
• The change in color between the beginning and ending

tints in the gradation described as a percentage.
• The physical distance between the beginning and end-

ing tints of the gradation described in points.
    
To calculate available tints and band widths, use the fol-
lowing three formulas in the order listed:
([Resolution (dpi)] / [Screen frequency
(lpi)]) [squared] + 1 = [a]

[a] x [amount of tint change in gradation] =
[b]

[length of area to be filled] / [b] = [c]
Where:
[a] is the initial number of tints available.
[b] is the actual number of tints available for the grada-

tion.
[c] is the size of each band or how visible it will be.
To calculate tints available and band size using the above
formulas:

1. Divide the printer resolution by the chosen screen fre-
quency. Square the integer value (discard any remain-
der or decimal), then add 1 to the result. This is the ap-
proximate number of tints the printer is capable of pro-
ducing using this resolution and screen frequency.
([Resolution (dpi)] / [Screen frequency
(lpi)]) [squared] + 1 = [initial number of
tints available]

2. When the number calculated for initial number of tints
available is higher than 256, reduce to 256. PostScript
cannot create more than 256 different tints per ink.

For example, when printing to a device with resolu-
tion set at 1270 dots per inch (dpi) and line frequency
specified at 150 lines per inch (lpi), the formula calcu-
lates roughly 72 available tints. Changing the resolution
to 2540 dpi, while keeping the screen frequency at 150
lpi, results in 287 available tints. Because PostScript is
only capable of 256 tints, you must use the number 256.

3. Multiply the initial number of tints available by the
amount of tint change in the gradation, expressed as a
decimal.
[Initial number of tints available] x
[amount of tint change in gradation] =
[actual number of tints available for the
gradation]

For example, for a 20% black to 80% black gradation,
the tint change is 60% or .60 when expressed as a deci-
mal. Because a tint change of less than 100% uses less
that 100% of the total available range of tints (e.g., 60%
of 256 tints is 153 tints), you must calculate the actual
number of tints available.

4. Measure the object in the direction of the gradation and
convert that length to points (72 points per inch).

5. Divide the length of the gradation by the actual number
of tints available to determine the width of each tint band
or the minimum width of objects used to create a blend.
[length of area to be filled] / [actual
number of tints available] = [size of each
tint band]

For example, when the gradation is 4 inches (288 points)
in length with 153 tints available, each tint band will be
about 1.9 points wide.
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When predetermining band widths for process color gra-
dations, calculate band widths for each of the four process
inks involved. You can calculate banding for the ink that
has the most change in color, and the ink with the least
change to determine the complete spectrum of expected
band widths. Banding in a lighter color (i.e., yellow) is less
evident when the final product is printed than banding in
a darker color (i.e., black).

 
Variables that affect banding are: resolution, screen fre-
quency, tint change in the gradation, and the length of the
gradation.

Adjust variables to reduce the width of tint bands by do-
ing one or more of the following:

a. Increase the resolution until the gray bands are thin
enough or until the number of initially available grays
passes PostScript’s limit of 256 gray levels. Raising reso-
lution after passing 256 tints is pointless because Post-
Script can only produce 256 tints per ink.

b. Lower the screen frequency value until the formula shows
the bands are thin enough or until the number of initially
available tints passes PostScript’s limit of 256 gray levels.
Lowering screen frequency after passing 256 tints is point-
less because PostScript can only produce 256 tints per ink.

c. Increase the difference in color between the starting and
ending tints in the gradation.

d. Decrease the length of the gradation.
or: Diffuse the hard edges of the tint bands by applying
noise to the gradation in an application that can open and
rasterize the gradation (e.g., Adobe Photoshop), or by
choosing an ink or absorbent paper stock that will aid in
diffusing the tint bands.
or: Replace the gradation by having your printer strip in a
pre-made gradation or by printing to a PostScript process-
ing system (e.g., Scitex system) that replaces gradations with
a proprietary smooth rasterized gradation.

[All, Feature Techniques, M|W|U, Issue/Solution, Medium, 2479]

PostScript Level 2 General Information

PostScript, developed by Adobe in 1985, is a page descrip-
tion language for printing and displaying documents that
integrate text, graphics, images, and color. PostScript imple-
mentations are organized into levels (i.e., Level 1, Level 2).
Several extensions have been made to the PostScript lan-
guage to adapt to new technology and to incorporate new
functionality and flexibility. PostScript extensions are col-
lections of language features that are not a standard part of
the language level.

PostScript Level 1 interpreters implement all Level 1
features documented in the first edition of the PostScript
Language Reference Manual.

PostScript Level 2 introduces new language features as
well as optimized text and graphic operators. Level 2 fea-
tures include CMYK color extensions, composite font ex-
tensions, and many of the Display PostScript extensions
that apply to raster devices. Because Level 2 supports Level
1 features and operators, applications that support print-
ing to Level 1 interpreters also support printing to Level 2
interpreters. PostScript Level 1 does not support all Level 2
features and operators. PostScript language applications
that support Level 2 operators and features do not auto-
matically support printing to Level 1 interpreters.

     
PostScript Level 2 provides improved and enhanced sup-
port for the following features:
Composite font

PostScript Level 2 incorporates the composite font ex-
tension. Composite fonts are a hierarchical collection of
base fonts (i.e., individual character descriptions) that sup-
port character sets larger than 256 characters and complex
character positioning. In PostScript Level 1, fonts are lim-
ited to 256 characters. Languages such as Japanese and
Chinese require character sets larger than 256 characters.
Data Compression and Decompression Filters

Data Compression and Decompression filters transform
data as it is being read from or written to a file. The
PostScript Level 2 language supports filters for ASCII HEX
coding, ASCII85 coding, LZW compression, Run-length
compression, CCITT fax compression (i.e., Group 3 and
Group 4), and JPEG compression.
Device-independent Color

PostScript Level 2 supports several device-independent
color spaces based on the international standard CIE 1931
(Commission International de l’Eclairage) as well as the
CMYK and RGB color models. CIE is a system for specify-
ing color values in a way that is related to human visual
perception. The CIE color models are based on visual color
perception rather than color production. The CIE color
system allows for device-independent color, which enables
you to create, view, and print color information with more
predictable results on a variety of displays and printers.
Forms

A form is a self-contained description of graphics, text,
or images painted multiple times on any number of pages
by using Form caches. To optimize the repeat uses of the
same from, the form cache uses a location in memory to
store recently used forms. When the form is requested, it is
retrieved from the form cache. If the form is not requested
within a predetermined amount of time, the form is de-
leted from memory.
Improved Halftoning Algorithms

PostScript Level 2 devices provide improved accuracy
of angles and frequencies for imagesetter halftone screens.
Halftone screen calculations are based on parameters such
as the exact screen angle and frequency requested, resolu-
tion of the device, and memory available for use by the al-
gorithm. PostScript Level 2 uses device-specific halftone
dictionaries to ensure hardware specific adjustments. A
halftone dictionary (e.g., type 1, type 3) is a self-contained
description of a halftoning process.
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Improved Memory Management
Memory in a PostScript Level 2 device is available to all

resources, resulting in dynamically-shared memory for in-
creased efficiency. In PostScript Level 2, the VM, stacks,
paths, font cache, form cache, and the page buffer expand
when necessary, sharing memory as needed. PostScript
Level 2 supports the removal of individual entries from
dictionaries and the removal of font definitions in an or-
der unrelated to the order in which they were created. Vir-
tual memory (VM) is reclaimed automatically for compos-
ite objects.
Patterns

PostScript Level 2 allows printers to paint with patterns
in addition to solid colors. Painting operators are used to
tile a pattern cell at fixed intervals to cover the area being
painted. The pattern cache is a location in memory where
recently used patterns are stored, optimizing the repeated
use of the same pattern. When the pattern is requested, it is
retrieved from the pattern cache. If the pattern is not re-
quested in a predetermined amount of time, it is deleted
from memory.
Resource Management

PostScript Level 2 enables quick storage and retrieval of
resources (e.g., fonts, forms, patterns, font encoding vec-
tors, and CIE-based color-rendering dictionaries). A re-
source is a collection of named objects that either reside in
VM or can be located and brought into VM on demand.
There are separate categories of resources with indepen-
dent name spaces.
Printer-specific features

The “setpagedevice” operator provides a device-inde-
pendent framework for specifying the requirements of a
page and for controlling both standard features (e.g., num-
ber of copies) and optional device features (e.g., duplex
printing, multiple paper trays).
PostScript Level 2 Operators

The following Level 2 operators, along with the Level 1
operators documented in the first edition of the PostScript
Language Reference Manual, are present the Level 2 imple-
mentation of the PostScript language.

<<
>>
arct
colorimage
cshow
currentblackgeneration
currentcacheparams
currentcmykcolor
currentcolor
currentcolorrendering
currentcolorscreen
currentcolorspace
currentcolortransfer
currentdevparams
currentglobal
currentgstate
currenthalftone
currentobjectformat
currentoverprint
currentpacking
currentpagedevice
currentshared
currentstrokeadjust
currentsystemparams
currentundercolorremoval
currentuserparams
defineresource
defineuserobject
deletefile
execform
execuserobject
filenameforall
fileposition
filter
findencoding
findresource
gcheck
globaldict
GlobalFontDirectory
glyphshow
gstate
ineofill
infill
instroke
inueofill
inufill
inustroke
ISOLatin1Encoding
languagelevel
makepattern
packedarray
printobject
product
realtime
rectclip
rectfill
rectstroke
renamefile
resourceforall
resourcestatus
revision
rootfont
scheck
selectfont
serialnumber
setbbox
setblackgeneration
setcachedevice2
setcacheparams
setcmykcolor
setcolor
setcolorrendering
setcolorscreen
setcolorspace



5 5 4 A d o b e  F A Q

P
O

S
T

S
C

R
I

P
T

F
e

a
t

u
r

e
 

T
e

c
h

n
i

q
u

e
s

setcolortransfer
setdevparams
setfileposition
setglobal
setgstate
sethalftone
setobjectformat
setoverprint
setpacking
setpagedevice
setpattern
setshared
setstrokeadjust
setsystemparams
setucacheparams
setundercolorremoval
setuserparams
setvmthreshold
shareddict
SharedFontDirectory
startjob
uappend
ucache
ucachestatus
ueofill
ufill
undef
undefinefont
undefineresource
undefineuserobject
upath
UserObjects
ustroke
ustrokepath
vmreclaim
writeobject
xshow
xyshow
yshow

[All, Feature Techniques, M|W|U, Issue/Solution, Medium, 2472]

Converting PostScript Files to EPS Graphics

To convert a PostScript file to an EPS graphic, you must
open it in a text editor and add lines that identify it as an
EPS graphic and specify the dimensions, or bounding box,
of the image contained in the file. Adding these lines does
not guarantee the file will conform to the EPSF specifica-
tion, but it may enable you to import a PostScript file into
an application when no other options are available.

To convert a PostScript file to an EPS graphic using a text
editor:

1. Using any PostScript downloading utility, download the
original PostScript file to a PostScript printer to ensure
it prints as expected.

2. Draw a box around the printed image that includes the
entire image, with a minimum of white space. This box
represents your bounding box.
3. Measure distance “a” from the lower-left corner of the

bounding box to the left edge of the paper. Note mea-
surement “a” in points. (To calculate points: 1 inch=72
points, and 1 pica=12 points.)

4. Measure distance “b” from the lower-left corner of the
bounding box to the bottom edge of the paper. Note
measurement “b” in points.

5. Measure distance “c” from the upper-right corner of the
bounding box to the left edge of the paper. Note mea-
surement “c” in points.

6. Measure distance “d” from the upper-right corner of
the bounding box to the bottom edge of the paper. Note
measurement “d” in points.

7. Open the PostScript file in a word processing applica-
tion. The lines at the top of the file are the header. The
subsequent lines are the PostScript description of the
image.

8. Edit your PostScript file so that it begins with the fol-
lowing lines:
%!PS-Adobe-2.0 EPSF-1.2
%%Creator: name
%%CreationDate: date
%%Title: filename
%%BoundingBox: a b c d
%%EndComments

where “name” is your name or initials, “date” is today’s
date in any format (e.g., 9/18/57 or September 18, 1957),
“filename” is the name of the PostScript file, and “a,”
“b,” “c,” and “d” are the measurements you noted in steps
3 - 6.
note: Do not insert blank lines between the lines of the
header.

9. Save the file in text-only format.
note: EPS files do not automatically include a screen
preview. If you import an EPS file that doesn’t contain
a screen preview into an application, the application dis-
plays a gray box. Inside the gray box are the title, cre-
ator, and creation date of the graphic, if those comments
are found inside the EPS file. Saving an EPS file that
contains a screen image in text-only (ASCII) format will
eliminate the screen preview.

[All, Feature Techniques, M|W|U, Issue/Solution, Medium, 2480]

Adding Custom Paper Sizes to a
Custom Printer File Using a Text Editor

Creating a custom printer file to supplement a PPD file
enables you to customize the printer information (e.g., resi-
dent fonts, paper sizes, virtual memory) your printer’s PPD
file contains. Most sheet-fed, desktop laser printers (e.g.,
Apple LaserWriter II NTX) do not support custom paper
sizes. As a result, the PPDShell.ps PostScript routine and
the Update PPD Addition or utility are unable to add cus-
tom paper size information to a custom printer file when
they query these printing devices. Printing devices that sup-
port variable paper sizes (e.g., imagesetters) support cus-
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tom paper size information and include the “*Variable-
PaperSize: True” line in their PPD file.

The following example creates a custom paper size
named “MyCustomPage” with dimensions of 3" x 4.5". Not
all PPD files include the “*PageRegion” keyword as the
“*PageSize” keyword can function as both the “*PageSize”
and “*PageRegion” keywords. The “*PageRegion” keyword
specifies input options, which are contained in the “*Page-
Size” keyword.

To add a new custom paper size to a custom printer file
using a text editor:

1. Open the custom printer file in a text editor that can
save in text-only format (e.g., Microsoft Word, Teach-
Text, MS-DOS Editor).
note: Some text editors (e.g., Microsoft Write, Notepad)
add invisible characters (e.g., end-of-file, line feed) to
the file that prevent applications or printer drivers from
parsing, or reading, the PPD file.

2. In the section containing the “*PageSize” keywords, add
a custom paper size after the last “*PageSize” line using
the following syntax:
For Normal orientation (1):
*PageSize MyCustomPage: “216 324 1
statusdict begin setpage end”
where:

“MyCustomPage” represents the name of your page,
with no spaces.

“216” is the small page dimension in points (72 points
= 1 inch).

“324” is the large page dimension in points.
For Transverse orientation (0):
*PageSize MyCustomPage.Transverse: “324 216
0 statusdict begin setpage end”
where:

“MyCustomPage.Transverse” represents the name of
your page, with no spaces.

“324” is the large page dimension in points.
“216” is the small page dimension in points.
note: When adding large paper sizes, low memory at
the printer causes a failed print job, cropped print job,
or a PostScript error. The total width plus margin of
the paper size must be less than or equal to the imageable
width of the imagesetter.

3. In the section containing the “*PageRegion” keywords,
add a line for the custom paper size after the last
“*PageRegion” line using the following syntax:
For Normal orientation (1):
*PageRegion MyCustomPage: “216 324 1
statusdict begin setpage end”

For Transverse orientation (0):
*PageRegion MyCustomPage.Transverse: “324
216 0 statusdict begin setpage end”

4. In the section containing the “*ImageableArea” key-
words, add a line for the custom paper size after the last
“*ImageableArea” line using the following syntax:
*ImageableArea MyCustomPage: “0 0 216 324”

where “0 0 324 216” sets the bounding box of the
imageable area for the page size.
5. Locate the “*PaperDimension” keywords, add a line for

the custom paper size after the last “*PaperDimension”
line using the following syntax:
For Normal orientation (1):
*PaperDimension MyCustomPage: “216 324”

For Transverse orientation (0):
*PaperDimension MyCustomPage: “324 216”

6. Save the custom printer file in text-only format in the
Printer Descriptions folder (Macintosh) or in the PPD4
subdirectory (Windows).

[All, Feature Techniques, M|W|U, Issue/Solution, Medium, 2481]

Creating a Minimum Custom
Printer File Using a Text Editor

PostScript Printer Description (PPD) files, provided by the
printer manufacturer, describe a printer’s standard configu-
ration. To provide more detailed information to your ap-
plications about your printer (e.g., custom page sizes,
linescreen and resolution combinations), supplement the
PPD file by creating a custom printer file.

Information in the custom printer file preceding the
“*Include” line overrides the same information in the PPD
file. The actual file name of the custom printer file is op-
tional. The line *Include: “PPD NAME HERE” specifies
which PPD file the custom printer file will supplement.

To generate a basic custom printer file using a word pro-
cessor or text editor:

1. Open a new file in a text editor that can save in text-
only format (e.g., Microsoft Word, TeachText, MS-DOS
Editor).
note: Some text editors (e.g., Microsoft Write, Notepad)
add invisible characters (e.g., end-of-file, line feed) to
the file that prevent the PPD file from being parsed.

2. Type the following lines:
*PPD-Adobe: “4.0”
*Include: “PPD NAME HERE”
*% End of Aldus PPD local customization file.

3. In the custom printer file, replace “PPD NAME HERE”
after the “*Include:” line with the corresponding PPD
file’s name, ensuring the straight quotes are not deleted
around the PPD file’s name. For example:
*Include: “LaserWriter II NTX v51.8”

4. Add custom page sizes, printer resident fonts, and cus-
tom line screen information between the *PPD-Adobe:
“4.0” and *Include: lines.

5. Save the file as text-only (ASCII) in the Printer Descrip-
tions folder in the Extensions folder (Macintosh) or in
the Aldus\Usenglsh\Ppd4 subdirectory (Windows).

[All, Feature Techniques, M|W|U, Issue/Solution, Medium, 2482]

Updating PPD Files to Reflect Available
Virtual Memory Using a Text Editor

Custom printer files supplement PPD files, enabling you to
customize printer information for a particular printer (e.g.,
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resident fonts, paper sizes, virtual memory). The “*FreeVM”
line in the selected PPD or custom printer file indicates the
amount of virtual memory (VM) in bytes available at the
printer. From available VM specified in the PPD file, appli-
cations that read PPD files determine how much VM is
needed to rasterize the page, and allocate the remaining
VM for downloadable fonts. When a document contains
complex graphics or several fonts that must download, and
the amount of available VM in the target printer is low, low
printer memory symptoms (e.g., long print times, “VMer-
ror” and “limitcheck” PostScript errors, font substitution)
or excessive print spooling times occurs.

To modify a custom printer file to reflect available VM of
a printer using a text editor:

1. Determine the amount of available VM the printer has.
For instructions, see below.

2. Open the custom printer file in a text editor that can
save in text-only format (e.g., Microsoft Word, Teach-
Text, MS-DOS Editor).
note: Some text editors (e.g., Microsoft Write, Notepad)
add invisible characters (e.g., end-of-file, line feed) to
the file that prevent applications and printer drivers
from parsing the PPD file.

3. Find or add the “*FreeVM” line before the “*Include
line.” For example:
*FreeVM: “x” (where “x” is the value of
virtual memory in bytes)

4. Select the VM value between the quotes and then change
the value to reflect the actual value of FreeVM in bytes.

5. Save the custom printer file in text-only format in the
Printer Descriptions folder (Macintosh) or in the Aldus-
\Usenglsh\Ppd4 subdirectory (Windows).
Options for Determining the Available Virtual Memory
(VM) at the Printer:

a. Use the Apple LaserWriter 8.x printer driver’s or the
Adobe PSPrinter 8.x printer driver’s Printer Info fea-
ture.

b. Download a PostScript routine that prints the value of
virtual memory in bytes.

c. Create a custom printer file using the Update PPD Ad-
dition or PPDShell.ps PostScript routine file.
a. To determine the available VM using the LaserWriter

8.x printer driver’s or the PSPrinter 8.x driver’s
Printer Info feature:
1. Open the Chooser and select the LaserWriter 8.x

or PSPrinter 8.x printer driver.
2. In the Chooser, select the printer, then click Setup.
3. Click Printer Info. If Printer Info is dimmed, click

More Choices and then Printer Info.
4. Click Update Info, then scroll through the Printer

Information list to locate the Total Memory Avail-
able and note the value.

5. Multiply the Total Memory Available number by
1,048,576 to convert from megabytes to bytes.
The value in bytes is the available virtual memory
value used in the *FreeVM line in the custom
printer file.
b. To download a PostScript routine that prints the
value of virtual memory in bytes:

Print the VM value by downloading a PostScript
routine to query the printer:

1. Open a new file in a text editor that can save as
text-only (e.g., Microsoft Word, TeachText, MS-
DOS Editor).

2. Type the following text exactly as shown to print
the amount of available VM:

%!PS
% Prints the FreeVM value
/Courier-Bold findfont 24 scalefont
setfont

vmstatus
100 500 moveto
(*FreeVM: ) show
16 string cvs show
pop pop
showpage

3. Save this file in text-only format with the name
“vmstatus.ps.”

4. Using a PostScript downloading utility (e.g.,
Adobe Font Downloader version 5.04, Apple
LaserWriter 8.0 Utility), download the vmstat-
us.ps file to the printer.

5. The printer prints the value of the printer’s avail-
able virtual memory in bytes. This is the avail-
able virtual memory value used in the *FreeVM
line in the custom printer file.

or: Create a log file (i.e., text file) with the available VM
by downloading a PostScript utility to query the printer:
1. Open a new file in a text editor that can save as

text-only (e.g., Microsoft Word, TeachText, MS-
DOS Editor).

2. Type the following text exactly as shown to save
the amount of available VM in a log file:
%!PS
% Returns FreeVM value in a log file
vmstatus
(*FreeVM: ) = =
pop popf

3. Save this file in text-only format with the name
“vmstatus.ps.”

4. Using a PostScript downloading utility (e.g., Apple
LaserWriter 8.0 Utility version 7.4.1 or later),
download the vmstatus.ps file to the printer.

5. The printer prints the value of the printer’s avail-
able virtual memory in bytes. This is the avail-
able virtual memory value used in the *FreeVM
line in the custom printer file.
note: The FreeVM value in the log file may yield
some special characters in the number (e.g.,
*FreeVM: L234454). Delete these special charac-
ters before copying the FreeVM value (e.g.,
*FreeVM: 234454).

c. Both the Update PPD Addition and the PPDShell.ps
PostScript routine file included with PageMaker 5.0x
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create a custom printer file that includes the avail-
able virtual memory for the targeted printer. You can
copy and paste the available virtual memory value
in the generated custom printer file into other cus-
tom printer files.

Unexpected Results
M A C  O S  /  W I N D O W S  /  U N I X

PostScript Error Troubleshooting Guide

PostScript errors are caused by miscommunication between
a printer and computer: either the PostScript code is not
understood by the interpreter at the printer, or it exceeds
one or more of the limits built into the PostScript language.
Printing to a printer that is low on memory, for example,
can give unpredictable results or generate a PostScript error.

There are two parts to a PostScript error: the error and
the offending command.

%%[Error: limitcheck; OffendingCommand:
image ]%%

The error (e.g., limitcheck) provides information as to what
type of PostScript error occurred. The offending command
(e.g., image) notes what was being processed at the time
the error occurred, and may at times appear to be merely a
string of nonsense characters. While it can be helpful to
know the meaning of the error or offending command,
many PostScript error issues can be resolved without this
information.

PostScript errors don’t display or print automatically—
you need to set up your computer to do so. If the display or
printing of PostScript errors is disabled on your computer
when a PostScript error occurs, your printer may appear to
process data but then stop without printing anything. To
view PostScript errors on the Macintosh, disable the Back-
ground Printing option in the Chooser. To print PostScript
errors in Windows, set up your printer driver to do so.

To print PostScript errors in Windows 95:
1. Choose Start > Settings > Printers.
2. Right-click on your target printer, then select Proper-

ties from the pop-up menu.
3. In your printer’s Properties dialog box, click the Post-

Script tab.
4. Select the Print PostScript Error Information option,

then click OK.
To print PostScript errors in Windows 3.1x:

1. In Program Manager, open the Control Panel in the
Main group.

2. Double-click on the Printers icon.
3. Select your target printer from the list of installed printers.
5. Click Setup, then click Options, then click Advanced.
6. In the Advanced Options dialog box, select the Print

PostScript Error Information option.
7. Click OK to close the remaining dialog boxes.
Some applications, such as Adobe PageMaker, have the abil-
ity to download their own error handlers. Refer to your
product user manual to verify whether your application has
this functionality. (In Adobe PageMaker, select the Include
PostScript Error Handler option in the Print Options dia-
log box to download PageMaker’s error handler.) Error
handler utilities can also be used with all applications.

The information that follows is divided into four sec-
tions: common causes of PostScript errors, techniques for
isolating the cause of an error, common PostScript errors
with their likely causes, and common Offending Com-
mands with their likely causes. While you may be able to
interpret an error message and quickly pinpoint the source
of a problem, you will most likely need to use troubleshoot-
ing techniques as well.

    
• Element on the page (text, or imported graphics such

as EPS, PICT, or WMF)
• Data corruption
• Damaged font
• Complexity (exceeds printers available memory)
• Communication error (devices on other ports, loose

wires, system level issues, problems with printer hard-
ware)

• Damaged printer driver
• Printing to a PostScript emulator (printer using a non-

Adobe licensed version of PostScript)

  
To isolate a PostScript error, first determine when it oc-
curs. Do you receive the error:

• When printing from just this application on this com-
puter, or from all applications on this computer?

If all applications generate the same error or exhibit
problematic behavior, you need to isolate which piece
of your system is not working properly. These PostScript
errors are typically communication errors, so potential
causes include damaged fonts, damaged system files, a
damaged printer driver, network spooling issues, or
problems with your printer hardware. Make sure that
your printer is turned on and check all cable connec-
tions. Contact your printer manufacturer or system soft-
ware support for assistance in isolating the problem.

• When printing a particular file created in this applica-
tion, or when printing any file created in the same ap-
plication?

Since PostScript errors can be related to file com-
plexity, individual elements on a page, or even a SCSI
port connection (e.g., for a scanner or external hard
drive), you will want to know just how widespread the
problem is. If every file created in this application gen-
erates a PostScript error when printed, you may need to
reinstall the application. It’s possible that your printer
is using a PostScript emulator (e.g., Pacific Page car-
tridge, Phoenix PostScript Interpreter) that handles
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PostScript generated by older or simpler applications,
or by older printer drivers that cannot process data from
updated or more demanding software and drivers. If
you know that your printer is a PostScript emulator, or
it’s simply an older printer, try printing to a device that
uses a current version of Adobe licensed PostScript (e.g.,
Apple LaserWriter II NTX, HP LaserJet 4 PostScript
printer). If you’re not certain whether you have a Post-
Script emulator or your printer is capable of support-
ing newer versions of PostScript, contact your printer
manufacturer.

It is also possible that you are using a particular font
or graphic in all of the files receiving a PostScript error.
As a test, try creating a new file, drawing a simple box
or line on the page and printing it. If your test file prints,
you’ll want to determine which element (text or graphic)
common to your files is causing the error. You may need
to update or reinstall one or more of your fonts. If a
specific graphic or all graphics from a particular appli-
cation seem to generate the error, you may need to en-
sure the graphic isn’t damaged or too complex, use a
different graphic format, or inquire about updates to
either application. Contact technical support for your
product if you need this kind of information.

• When printing all pages or just one?
If you can isolate the problem to one or several files,

you may also find that the problem occurs only when
printing specific pages. To troubleshoot problems oc-
curring when printing multiple pages, look for com-
mon elements. Perhaps you are using the same element
(graphic or text) on more than one page. Items like a
company logo or corporate font are suspect if they ap-
pear on problematic pages.

Whether the error is specific to one page in a single
file, or whether it occurs on several pages of different
files, use the following techniques to isolate the prob-
lem. Open a copy of your file and try printing half of
the elements on the page. If you still receive an error,
try printing the other half of the page. Try deleting ele-
ments from the page until you are able to print. No out-
put, even when all elements have been removed, indi-
cates the file itself is probably damaged. To ensure the
file is not damaged, copy and paste all of the elements
from this file into a new one, save it with a different
name, and print. If you are able to print by reducing the
information on your page, you most likely have an ele-
ment on the page that contains some bad information,
or your file is simply too complex for your printer’s ca-
pabilities.

In the process of deleting elements from the page,
you may already have identified which item is causing
the error. If not, try printing text and drawn elements
but no imported graphics. Some applications, such as
Adobe PageMaker, give you the option to proof print a
file (i.e., print all elements on a page except imported
graphics). Check your application’s user manual to see
if this option is available. An imported graphic can cause
a PostScript error if it contains damaged or poorly writ-
ten information, or if it is extremely complex (e.g., con-
tains custom fills, complex type effects, nested objects,
or many points on a path). It’s possible to create a
graphic or file of such complexity that even a high-end
printing device cannot process the data required to out-
put it. Also, graphic formats are updated periodically,
so an EPS file created from an application purchased
four years ago isn’t based on the same standard as an
EPS file created in a newer application.

Once you’ve identified which graphic seems to gen-
erate the error, try re-importing it into your file. If this
does not work, try re-exporting it from the source ap-
plication in the same or a different format, and then re-
importing it. Check whether the graphic prints from
your application if it is the only element in a new file. It
may be complex enough that combining it with other
elements on a page is too much for your printer. A
graphic that won’t print as the only element in a new
file is damaged. A graphic that prints, but not in combi-
nation with other elements, is generating errors related
to printer memory.

You may also find that the error can be isolated to a
particular piece of text on the page, or to any text as-
signed a specific font. Try retyping the text you’ve
identified as the source of problems. If you suspect a
font rather than specific text, assign a different font for
all occurrences of the suspicious font. Your original font
may be damaged, or may not meet industry standards
for font specifications.

• When printing complex files, or files containing com-
plex elements?

If this is the case, you need to consider simplifying
your file. Some applications, such as Adobe PageMaker,
are not designed to create complex elements, but do al-
low you to import such elements from other sources.
Applications like Adobe Illustrator or Adobe Photoshop
enable you to create complex files without importing
any data. To simplify a file in an application like Page-
Maker, you may need to use fewer imported items or
fewer fonts that must be downloaded to your printer. If
your application can generate complex elements, you
may need to user fewer points on a path, reduce the
number of items that have been copied or cloned mul-
tiple times, or simplify customized fills or gradients.
Errors related to complex text effects (e.g., text that has
been skewed, rotated, or kerned) may be eliminated by
converting the text information to outlines or paths. EPS
files can often be identified as the source of a PostScript
error because they may contain complex information.

The information included in this publication is by no means
an exhaustive reference for understanding and trouble-
shooting PostScript issues. You will be able to handle many
of your own PostScript printing problems by using these
techniques, and in the case of exceptionally difficult issues,
you will be much better prepared to provide a technician
with information needed to resolve your issue quickly.

[All, Unexpected Results, M|W|U, Issue/Solution, Medium, 2473]
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error description likely cause solution
dictfull Related to a PostScript dictionary -Imported graphic Isolate problem element.

being mismanaged, too full, or -Damaged font
damaged. -Data corruption

fatal system error at Indicates the printer is completely -The printer memory require- Simplify your
[number string] out of memory, while the number ments of the file are too high publication, restart

following the error is a memory for the current memory your printer.
location in the printer. state of the printer.

limitcheck A PostScript implementation limit -Printer memory requirements Check offending
has been exceeded. of file, or a limit as defined in command

PostScript has been reached.
VMerror Out of printer memory. The offending Printer memory requirements Simplify page,

command is where processing stopped of file. or modify PPD file if
stopped when memory ran out. An applicable.
attempt was made to create a new
composite object (string, array, or
dictionary) that would exhaust Virtual
Memory resources.

Communication Errors

error description likely cause solution
ioerror Bad data transmission, cannot read -Communication error Try printing from a

or write data. -Binary image data (TIFF, different application,
EPS, or DCS graphics) reinstall printer
-Disk errors driver, omit graphic
-Damaged Printer Driver data.

timeout A time limit has been exceeded (e.g., -Large imported graphics Isolate element,
communication limit between the -Complex fill patterns increase timeout
computer and printer). -Complex type effects settings.

-Network problems
-Nested grouped elements

postscript code errors

error description likely cause solution
invalidrestore Improper attempt to restore. -Imported graphic Isolate element.

-Data corruption
stackoverflow, There are either too many objects -An offending element Isolate element,
stackunderflow (values or commands) on one of the -Imported graphic simplify page.

PostScript stacks (overflow) or -Memory problem
an object is missing (underflow). -Data corruption

-Communication error
typecheck An object or value does not match -An offending element Isolate element, copy

PostScript expectations Typecheck -Imported graphic and paste data to new
does not necessarily imply problems -Data corruption file.
with text.

undefined A keyword, value, or object is -A printer prep file or Post- Isolate element, try
encountered that cannot be defined. Script dictionary is missing printing from a

-Imported graphic different application,
-Damaged font copy and paste data to
-Data corruption a new file, if converted
-Communication error from a previous version,
-Missing PostScript header try printing again
information from that version.
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Offending Commands Related to Complexity

Command Likely Cause
charpath Complex text or text effects.
clip, eoclip Graduated or radial fills, complex or compound paths, text effects, masks.
curveto Complex curve paths.
fill, eofill Complex or compound paths.
lineto, moveto Paths composed of many points (may include converted PICT graphics).
makefont Text effects (includes scaled, skewed, rotated, or reflected text).
stroke Complex paths, paths with complex fills and outline strokes, or converted PICT graphic.

note: A complex path can be described as one that contains many points; a path may be too complex for the
current flatness settings of an element in your illustration application. Refer to your user manual for more
information about flatness settings.

Offending Commands Related to Printer Memory

Command Likely Cause
def Printer memory, printer fonts, or imported graphics.
dict Printer memory, printer fonts (see errors related to system components).
framedevice Printer memory, printing from an older application, using an outdated printer driver (PostScript level 1 only).
index Printer memory, imported graphics.

Offending Commands Related to One or More Elements on a Page

Command Likely Cause
ashow, widthshow Offset text (e.g., kerned text, super or subscripted text, custom letter or word spacing)
awidthshow or damaged font.
colorimage Color bitmap images.
currentpoint Imported graphic, elements created in application.
def Imported graphic (may also be related to printer fonts or printer memory).
exch Imported graphic (may also be related to a damaged font).
get Imported graphic.
image Bitmap or paint-type images.
imagemask 1-bit or paint-type bitmap image, bitmap fonts.
index Imported graphic (may also be related to low printer memory).
itransform Very small element.
kshow Kerned text, including pair kerning.
nostringval An offending element, perhaps an imported graphic (may also be related to a damaged font).
packedarray Imported graphics (may also be related to data corruption, or printing to a PostScript emulator).
put Custom fills (may also be related to a damaged font).
setdash Custom PostScript line, imported graphic with custom lines.
setgray Tints, imported EPS files, fonts created with old versions of Fontographer.
setlinecap Custom PostScript line, imported graphic with custom line.
setlinejoin Custom PostScript line, imported graphic with custom line.
show Text (includes text in an imported EPS graphic).
stringwidth Text (includes text in an imported EPS graphic).
character string Imported image file (damaged, very high resolution, poorly written), data corruption.

Offending Commands Related to Damaged System Components

def Printer fonts (also imported graphics, printer memory).
dict Printer fonts (also printer memory).
exch Damaged font (also imported graphics).
flxproc Damaged font.
nostringval Damaged font (also specific element on the page).
put Damaged font (also related to custom fills in graphic elements).
setpageparams Page or paper size selected in application exceeds the imageable area defined in the PPD for this printer. PPD

may have been incorrectly edited.
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Printer Inaccuracy General Information

When PostScript code contains accurate numbers, inaccu-
rate output from a PostScript printing device is due to the
printing device itself. It is up to the printer to control pa-
per feed and paper stretch for accurate output. When pa-
per or film stretches, or other printer adjustments are
needed, output will vary from specified.

A test file containing PostScript code describing one
easily measured element (e.g., 4-by-4" square), can be
downloaded to check printer accuracy and eliminate soft-
ware as a cause of inaccuracy.

The following PostScript file creates a 4-by-4" box, which
you can downloaded directly a printer several times. If the
result is slightly, but consistently off, the printer, not the soft-
ware, is the source of the inaccuracy. Because of paper stretch,
this inaccuracy is usually in length, rather than width.

If you print the same PostScript box to another printer,
the result will be consistent on that printer, but may be dif-
ferent from the output on another printer.

To create a PostScript file describing a 4-by-4" square:
1. In a word processing program that can save in text-only

(e.g., Microsoft Word, TeachText) type the following
code:
%% 4 inch black box with no stroke
144 288 moveto
0 288 rlineto
288 0 rlineto
0 -288 rlineto
closepath
fill
showpage

2. Save as text-only with the name “4 inch box.ps.”
3. Download the 4 inch box.ps file to the printer using a

downloading utility (e.g., Adobe’s Font Downloader,
Apple’s LaserWriter Font Utility).

[All, Unexpected Results, M|W|U, Issue/Solution, Medium, 2474]

Error Opening or Separating a DCS File
with a Name Beginning in a Space


An error occurs when you open or print a DCS file whose
name begins with a space character.


When opening a DCS file, Adobe Photoshop 2.5.1 returns
the error, “Could not open a DCS color plate because File
not found.”

When separating a linked DCS file, PageMaker 5.0x re-
turns the error, “Some DCS files could not be found. Check
main DCS link and re-link if necessary. Make sure DCS
files are kept in same folder as the main file. 7816:5827.”

When separating a linked DCS file, QuarkXPress 3.3 re-
turns the error, “Couldn’t find the DCS plate ‘[file name.C]’
for ‘[file name]’ OK to print missing plates in low resolu-
tion?”

Remove the space character from the beginning of each of
the DCS separation files. For example, change “ filename.C”
to “filename.C.”
or: Open and print the DCS file from Photoshop 3.0.

 
Desktop Color Separation (DCS) files consist of five files: a
main composite file and four process separation files (e.g.,
“filename.C,” “filename.M,” “filename.Y,” and “filename.K”).
When a DCS file is opened or separated, information in
the main file is used to link to each of the separation files.
Some applications (e.g., Photoshop 2.5.1, Page-Maker 5.0x,
QuarkXPress) cannot link to DCS separation files when any
of their filenames begin with the space character. For ex-
ample, when you open a DCS main file that links to sepa-
ration files whose names begin with a space (e.g.,” file-
name.C”) in Photoshop 2.5.1, Photoshop returns the mes-
sage, “Could not open a DCS color plate file because File
not found.”

[All, Unexpected Results, M|W|U, Issue/Solution, Medium, 2475]

PostScript Error “Undefined;
OffendingCommand: featurecleanup”
When Printing


When you print a document using the LaserWriter 8.1.1
printer driver, the PostScript error, “Undefined; Offending-
Command: featurecleanup” appears.


In the LaserWriter 8.1.1 printer driver, the printer is set up
with a PPD (PostScript Printer Description) file that con-
tains the “*JobPatchFile:” or “*PatchFile:” keyword.

The PPD file selected in the application’s print dialog
box (except PageMaker 5.0x’s) contains the “*JobPatchFile:”
or “*PatchFile:” keyword.

You are printing from PageMaker 5.0x with Background
Printing enabled.

You are printing a PageMaker 5.0x publication contain-
ing a PICT, CGM, WMF, DXF, or OLE PICT graphic.


If you’re printing from PageMaker 5.0x, turn off Back-
ground Printing in the Chooser.
or: Make sure an imported graphic is not causing the error
by printing the file or page without any imported graphics
(e.g., select the Proof option). After isolating an offending
graphic, resave the graphic and replace.
or: If you’re printing from an application other than
PageMaker 5.0x, do one or more of the following:
a. In the Chooser, select the LaserWriter 8.1.1 printer

driver, select your printer and click Setup, click the Se-
lect PPD option, then change the printer’s associated
PPD file to one that doesn’t contain the *JobPatchFile
or *PatchFile keyword.
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b. In the printing application, select a PPD file that doesn’t
contain the *JobPatchFile or *PatchFile keyword.
or: Print using the LaserWriter 8.0 or earlier printer
driver.

 
When you print using a PPD file that contains a *JobPatch-
File or *PatchFile keyword, the “featurecleanup” command
is needed to handle the *JobPatchFile or *PatchFile key-
word. The LaserWriter 8.1.1 driver uses the “featurecleanup”
command before it is defined in PostScript, resulting in the
PostScript error “undefined; OffendingCommand: feature-
cleanup.”

PPD files modified to prevent TIFF images from print-
ing too dark or light from PageMaker 5.0, the Apple Laser-
Writer PPD file included with PageMaker 5.0, and other
PPD files (e.g., AccelaWriter 8000 [PM50] and AccelaWriter
4000 [PM50]) contain the a *JobPatchFile or *PatchFile
keyword.

If you choose File > Print in PageMaker without press-
ing the Option key, PageMaker generates the PostScript code
for the publication itself, with the exception of PostScript
fonts and PICT graphics. PageMaker 5.0x uses the Laser-
Writer 8.x printer driver to convert PICT files (including
converted CGM, WMF, DXF or OLE PICT graphics) to EPS
graphics. PageMaker uses the LaserWriter printer driver to
generate the PostScript code for the entire publication you
hold down the Option key while choosing File > Print.

If you print from PageMaker 5.0x with Background
Printing enabled, the PPD file associated with the printer
specified in the LaserWriter 8.1.1 printer driver is read, caus-
ing the “undefined; OffendingCommand: featurecleanup”
PostScript error when the associated PPD file contains ei-
ther the *JobPatchFile or *PatchFile keyword.

[All, Unexpected Results, M|W|U, Issue/Solution, Medium, 5572]

Low Line Screens Not Printing as Specified


When you print a document to a PostScript device, it prints
at a higher line screen frequency than the low value you
specified.


Disable screening or calibration software at the imagesetter’s
RIP (raster image processor).
or: Print to another device capable of printing the desired
line screen value.

 
The lowest line screen (lpi) value that a printer can image
varies from printer to printer. Screening or calibration soft-
ware (e.g., Agfa Balanced Screens, HQS screens) may pre-
vent some custom screen frequencies from printing, be-
cause it optimizes screen and angle rulings for the image-
setter.
You can determine the lowest line screen value possible for
your printer by downloading a PostScript file to it that draws
a tinted box set to 1 line per inch (lpi). To create the file:

1. Create a new file in a text editor that can save in text-
only format (e.g., TeachText, Notepad) 2. Type the fol-
lowing text exactly as shown:
 gsave
1  %% This number is the screen frequency
45  %% This number is the screen angle
{180 mul cos exch 180 mul cos add 2 div}  %%
This is the spot function

setscreen
%% 4 inch box, 20% fill, 1 pt. black stoke
144 288 moveto
0 288 rlineto
288 0 rlineto
0 -288 rlineto
closepath
gsave
.8 setgray
fill
grestore
stroke
grestore
showpage

2. Name the file “20box.ps” and save it in text-only format.
3. Disable all calibration and screening software at the

imagesetter.
4. Download the PostScript file to the printer.
5. Measure the line screen value in the 4-inch box. This is

the lowest lpi value your printer can produce.

General Information
M A C  O S  /  W I N D O W S  /  U N I X

PostScript Printer Memory General Information

PostScript printer memory (RAM) is divided into sections,
which are used in the following order:

1. Frame buffer (builds the page with pixels).
2. Prep files (dictionaries used by the printer to define

PostScript).
3. Fonts manually downloaded using a downloader util-

ity.
4. PostScript information describing each print job.
5. Fonts downloaded to RAM during printing.
The majority of PostScript printer memory is dedicated to
the frame buffer to build the page. The higher the resolu-
tion and the larger the page, the more memory the frame
buffer requires. For example, when you print a letter-size
page to a standard Apple LaserWriter NTX printer at 300
dpi, there is 150K to 300K of available memory for prep
files, fonts downloaded to memory, and the PostScript file
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you’re trying to print. Although imagesetters come with
more memory than laser printers, they require more to cre-
ate more pixels to print high resolution.

[All, General Information, M|W|U, Issue/Solution, Medium, 7311]

Troubleshooting PostScript Errors

PostScript errors are caused by PostScript code that is not
understood by the printer’s PostScript interpreter, or Post-
Script code that exceeds one or more of the limits built into
the PostScript page description language. PostScript error
messages include a PostScript error type, which is one of a
relatively limited number of different types, and an offend-
ing command, which can be any combination of ASCII
characters. PostScript errors usually look like:

%%[Error: <ty pe>; OffendingCommand: <offend-
ing command> ]%%

For example, the PostScript error %%[Error: dictfull;
OffendingCommand: def ]%% contains the PostScript er-
ror type “dictfull” and the offending command “def.” The
error type indicates what kind of problem the PostScript
interpreter had; the offending command is the last com-
mand it tried to process, and is sometimes, but not always,
the command that caused the problem.

Some PostScript errors will point you right to the cause
of the problem, and some will get you looking in the right
direction. If your printer appears to process data but then
stops without printing anything, it may have encountered
a PostScript error. If you don’t get the PostScript error read-
out, you can coax one from your printer in any of these
ways:

In Windows 95:
1. Choose Start > Settings > Printers.
2. Right-click on your target printer, then select Proper-

ties from the pop-up menu.
3. In your printer’s Properties dialog box, click the Post-

Script tab.
4. Select the Print PostScript Error Information option,

then click OK.
In Windows 3.1x:

1. In Program Manager, open the Control Panel in the
Main group.

2. Double-click on the Printers icon.
3. Select your target printer from the list of installed printers.
5. Click Setup, then click Options, then click Advanced.
6. In the Advanced Options dialog box, select the Print

PostScript Error Information option.
7. Click OK to close the remaining dialog boxes.

On the Macintosh:
• Select either Summarize on Screen or Print Detailed Re-

port in the PostScript Error pop-up menu in the Apple
LaserWriter 8.x or Adobe PSPrinter 8.x Print Options
dialog box.

• Disable print spoolers, including Background Printing.
To disable Background Printing, in the Chooser, select
your printer driver and then select Off for the Back-
ground Printing option.
In Windows or on the Macintosh:
Use an error handler utility designed to work with mul-
tiple applications or use an error handler supplied by your
application, if available. For example, Adobe PageMaker
offers the Include PostScript Error Handler option in the
Print Options dialog box.

  
To begin troubleshooting your printing problem, use the
PostScript Error Types and the PostScript Offending Com-
mand sections below. The PostScript Error Types section
lists common error types under a general cause, and the
PostScript Offending Command section lists common of-
fending commands under what most likely caused the error.

For example, to use these sections after you receive the
PostScript error, %%[Error: limitcheck; OffendingCom-
mand: image ]%%, locate the “limitcheck” type and “image”
offending command in the sections. The PostScript Error Types
section lists “limitcheck” under “Exceeds printer’s memory or
PostScript language limit.” The PostScript Offending Com-
mand section lists the “image” offending command under
“bitmap data.” By putting these two together, you have a prob-
able cause—a bitmap image exceeds the printer’s available
memory (or other PostScript language limit). In such a case
you’d probably need to simplify the bitmap graphic by resam-
pling or rescanning it at a lower resolution, or by printing to a
printer that has more available memory.

Some PostScript errors won’t help you pinpoint a likely
cause. For example, if you receive the PostScript error,
%%[Error: undefined; OffendingCommand: (random
characters) ]%%, the PostScript Error Types section lists
“undefined” under “Errors that indicate unintelligible
PostScript code” and the PostScript Offending Command
section lists “[random characters]” under “any element or
file.” In this case, you’ll need to continue troubleshooting
to isolate the cause of the problem.

  
Errors that indicate something exceeds the printer’s mem-
ory or a PostScript-language limit:
dictfull
fatal system error at [various]
limitcheck
VMerror
Errors that indicate communication problems:
interrupt
ioerror (May also be caused by a disk
problem, such as a bad sector, on the
printer’s hard disk.)

timeout
Errors that indicate unintelligible
PostScript code:

dictstackoverflow
dictstackunderflow
execstackoverflow
handleerror
invalidaccess
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invalidexit
invalidfileaccess
invalidfont
invalidrestore
nocurrentpoint
rangecheck
stackoverflow
stackunderflow
syntaxerror
typecheck
undefined
undefinedfilename
undefinedresult
unmatchedmark
unregistered

  
Offending commands associated with specific text or font
element:
ashow
awidthshow
charpath
definefont
findfont
imagemask
kshow
makefont
selectfont
show
stringwidth
widthshow

Offending commands associated with specific masks (clip-
ping paths):
clip
eoclip

Offending commands associated with fills and lines, often
in imported object-oriented, or vector, graphics (EPS files
or PICT graphics, for instance):
arc
arcto
currentpoint
curveto
eofill
fill
lineto
moveto
rcurveto
rlineto
setdash
setlinecap
setlinejoin
stroke

Offending commands associated with bitmap data:
colorimage
image
imagemask (Associated with 1-bit image
bitmap graphics and bitmap fonts.)
Offending commands associated with any element or file:
array
def
dict
exch
get
index
itransform
nostringval
packedarray
put
restore
save
setgray
setpageparams
setscreen
[random characters]

  
While many PostScript error quickly pinpoint the source
of a problem, you’ll need to troubleshoot your printing
problem if you don’t receive an PostScript error message,
or if the PostScript error doesn’t limit the number of likely
causes. To troubleshoot your printing problem, isolate when
the problem occurs to determine if it is a system-level, ap-
plication-specific, file-specific, or element-specific problem.
After narrowing down when the problem occurs, eliminate
likely causes until you solve the problem.

 -  
Do you receive the error when you print from multiple
applications? If the same problem occurs when you print
from multiple applications, the cause is most likely a prob-
lem at the system level. System-level problems are com-
monly caused by damaged fonts, damaged system files,
damaged printer drivers, insufficient hard disk space, net-
work problems, or hardware problems.

Check for loose cables or faulty connections by secur-
ing loose cables by unplugging and replugging them. If there
are any other devices that your print job needs to travel
through (like a switch box), check their connections, too.
Problems caused by severed connections have unambigu-
ous symptoms: your printer won’t receive data, so it won’t
do anything—none of its readouts will blink, and it cer-
tainly won’t print anything. But when you have a loose con-
nection, the symptoms of your problems might be more
ambiguous: small jobs might print, but larger jobs won’t,
and on a Macintosh, the printer in your Chooser might
appear and disappear intermittently.

Make sure you are using an up-to-date PostScript printer
driver, or use the version of the PostScript printer driver
required by your application. You also need plenty of free
hard-disk space to print, especially when you print large
documents. And for fast and efficient printing, make sure
your free hard-disk space is unfragmented, especially on
the disk your system uses to create temporary files, which
is usually the disk that contains your operating system.
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If your printer is an older PostScript printer or one that
uses a PostScript emulator (e.g., Pacific Page cartridge,
Phoenix PostScript Interpreter), it may not understand the
newer PostScript code generated by your application or
printer driver. To rule out this cause, try printing your file
to a device that uses a more current or up-to-date version
of Adobe licensed PostScript.

 - 
Do you receive the error when you print any file from a
single application? You can easily determine if you only re-
ceive the error in a single application by creating a new test
file that contains only a simple element, such as a rectangle
or line. If this test file prints, continue troubleshooting for
file-specific causes. If you receive a PostScript error when
you print any file from the same application, rule out dam-
aged application software as the cause by reinstalling the
application, including its support files and preferences file.

 - 
Do you receive the error when you print a specific file, or
specific files, from a single application? If the error occurs when
you print a specific file, the file may be damage, or it may con-
tain a damaged element or an element that doesn’t print be-
cause of another reason. Begin troubleshooting by checking
your file’s print settings against those of a file that does print.

To rule out file damage as the cause, copy the file’s ele-
ments into a new file, save your file using the Save As com-
mand, delete elements you don’t need to print, or run any
built-in diagnostic routines your application offers. In
PageMaker, for instance, you can repair certain file prob-
lems by using its Diagnostic Recompose feature: deselect
all elements in the file, then choose Type > Elements while
you hold down the Ctrl and Shift keys (Windows) or the
Option and Shift keys (Macintosh). If, after you rule out
file-specific causes, you still receive the error when you print
the file, troubleshoot file-specific problems.

 - 
Do you receive the error when you print only a specific
page or elements on a page? After you’ve ruled out a dam-
aged file as the cause, the cause of your printing problem is
most likely a damaged or incorrectly written element or
font, or by an element or combination of elements on a
page that requires more printer memory than is available.
If you receive the error when you print a range of pages,
look for common elements. If you can print all elements
individually or in small groups, but not all at the same time,
t
i

o

the combination of elements you are printing requires more
printer memory than your printer has available.

To isolate the element, or elements, causing your prob-
lem, make a copy of your file and print groups of pages,
and then one page at a time, until you’ve narrowed down
the problem to a specific page or range of pages. After nar-
rowing down which page or page range is causing the prob-
lem, isolate the element causing the problem by removing
an element from the page and then printing. Continue until
you can print the file without receiving the error. (You can
also remove elements in groups to narrow down the prob-
lem faster. For example, remove half of the elements in your
file and then print your file. If the error doesn’t reoccur,
print the other half of the elements.) Some applications,
such as PageMaker, offer an option that enables you to print
some elements but not others. For example, when you print
from PageMaker by selecting the Proof Print option, Page-
Maker prints the text but not the graphics. Using this op-
tion, you can quickly determine if your problem is caused
by an imported graphic or other element in your PageMaker
publication.

If the element causing your problem is text or an ele-
ment you’ve created in the application, recreate the element.
For text elements, also try using a different font (e.g., refor-
mat the text using a different kind of font or a printer-resi-
dent font). If your file prints when you use a different font,
reinstall the original font to eliminate damaged font files as
the cause.

If the element causing the problem is an imported
graphic, first try reimporting the graphic. If the printing
problem still occurs, open the graphic in the application in
which it was created, resave it, ensure it prints from this
application, then reimport the graphic. If you still can’t print
the imported graphic, try resaving it in a different format,
exporting it from a different application, or simplifying it
so that it requires less printer memory.

An imported graphic can cause a PostScript error if it
contains damaged or incorrectly written information, or if
it too complex for your printer (i.e., it requires more
memory than your printer has available). To begin simpli-
fying a file, use fewer imported graphics, use fewer fonts
that must be downloaded to your printer, use fewer text
effects (e.g., skewed or rotated text, type effects), delete el-
ements you don’t need, create paths using fewer points, or
resample or rescan bitmap images at a lower resolution.
Graphic formats such as EPS are updated periodically, so
older applications may use an older standard that newer
software or hardware may not understand.
n
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Feature Techniques
W I N D O W S

Adding Printers Using AdobePS 4.1 Setup Utility

The AdobePS 4.1 PostScript Printer Driver supports Win-
dows 95, but does not support Windows 3.1x, Windows
for Workgroups, or Windows NT.

To install printers with AdobePS 4.1:
1. Launch the AdobePS 4 Setup Utility by choosing Start

> Programs > AdobePS4.
2. In the AdobePS 4 PostScript Printer Driver Setup dia-

log box, click Next.
3. When your printer is connected directly to your com-

puter, select Local Printer, then click Next in the Printer
Type dialog box.
or: When your printer is connected through a network,
select Network Printer, then click Next in the Printer
Type dialog box. In the Network Path dialog box, type
the network path or queue name, or click Browse to lo-
cate the printer, then click Next.

4. In the Install PostScript Printer from PPD dialog box,
install PPD files by doing one or more of the following:
a. Locate the folder on your hard disk that contains

PPD files (e.g., C:\PM6\RSRC\USENGLSH\PPD4),
then select one or more PPD files by double-click-
ing the printer’s name, or clicking the printer’s name
then clicking Next.

b. To install PPD files included on the AdobePS 4.1 CD-
ROM:
1. In the Drives list, select the drive indicator for

your CD-ROM drive.
2. In the Directories list, open the PPDs folder lo-

cated in the Drvrdisk folder in the Adobeps folder
on the CD-ROM.

3. Open the folder with the name of your printer’s
manufacturer (e.g., Agfa, Hewlett-Packard, IBM).

4. Select the printer you want to install by double-
clicking the printer’s name, or clicking the print-
er’s name then clicking Next.

5. When installing a local printer, select a port from
the list of available ports in the Local Port Selec-
tion dialog box, then click Next.
6. In the Add Printer dialog box, accept the default

name for the printer, or type in the preferred name,
select Yes if you want this printer to be the default
printer for your Windows applications, select Yes
if you want to print a test page, then click Next.

7. In the Properties dialog box, adjust the Proper-
ties for your printer as desired, then click OK to
return to the AdobePS 4 PostScript Printer Driver
Setup.

8. In the Setup dialog box, either click Exit to quit
AdobePS 4 PostScript Printer Driver Setup or
click Add Another then repeat steps 3-8 to add
another printer.

M A C  O S

Setting up Spooling Location for PSPrinter 8.x

When you spool print jobs using the Adobe PostScript
printer driver 8.x (PSPrinter), you can use PSPrinter’s de-
fault spooling location, or you can change the default spool-
ing location so that PSPrinter spools files to another local
hard disk or Macintosh on the network.

    
By default, PSPrinter 8.x spools print jobs to the startup hard
disk, using its available hard disk space to store information.
When Background Printing is Off, PSPrinter spools files to
the temporary folder it creates, which it names Printing Temp
Folder (PSPrinter 8.1 and later) or PSPrinter Temp Folder
(PSPrinter 8.0) and locates in the Extensions folder in the
System Folder. When you print with Background Printing
enabled, Apple’s PrintMonitor spools files to the Print-Moni-
tor Documents folder in the System Folder. After Print-Moni-
tor spools the file to the Printing Temp Folder, PSPrinter
Temp Folder, or PrintMonitor documents folder, PSPrinter
converts it to PostScript code, compresses it for faster trans-
mission to the printer, then sends it to the printer.

If there is not enough disk space for the spooled file on
the hard disk, PSPrinter returns a Disk Full error. To prevent
a Disk Full error, remove files on the startup disk (i.e., vol-
ume containing the active system software) to ensure there
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is sufficient available disk space, or spool to another volume
(local or remote hard disk) that has more available space.

     
You can set up PSPrinter to spool to another local hard
disk (e.g., external hard disk) when you print in Foreground
printing mode (i.e., Background Printing is turned Off in
the Chooser).

To set up PSPrinter to spool to another local hard disk:
1. On the disk you want to spool to, create a new folder

and name it “Printing Temp Folder” (PSPrinter 8.1 and
later) or “PSPrinter Temp Folder” (PSPrinter 8.0).

2. Create an alias of the newly created folder by selecting
it and then choosing File > Make Alias.

3. Move the alias into the Extensions folder in the System
Folder.

4. Select the alias and rename it “Printing Temp Folder”
(PSPrinter 8.1 and later) or “PSPrinter Temp Folder”
(PSPrinter 8.0).

5. In the Chooser, select PSPrinter, select Off for Back-
ground Printing, and then close the Chooser.

      
Before setting up PSPrinter to spool documents to another
Macintosh on the network:

• Install System 7.x on both Macintosh computers.
• Install the same version of PSPrinter 8.x (e.g., PSPrinter

8.3) on both Macintosh computers.
• Enable Background Printing in the Chooser on both

Macintosh computers. When Background printing is en-
abled, any error generated by PrintMonitor appears only
on the local Macintosh.

• Install the same fonts on both Macintosh computers.
• Disable virus protection utilities (e.g., Symantec AntiVirus,

Norton Utilities) on both Macintosh computers.
To set up PSPrinter to spool to a Macintosh on the network:

1. On the remote Macintosh (i.e., the Macintosh that you
are spooling to), open the Chooser.

2. In the Chooser, select PSPrinter, select a destination
printer, select On for Background Printing, then close
the Chooser.

3. Open the Sharing Setup control panel, click Start in the
File Sharing section, then close the control panel.

4. In the Finder, select the System Folder, then choose File
> Sharing.

5. In the Sharing dialog box, select the option labeled
“Share this item and its contents.” For the Everyone op-
tions, select See Folders, See Files, and Make Changes.
Select the option labeled “Can’t be moved, renamed or
deleted” and then close the Sharing dialog box.

6. In the System Folder, select the PrintMonitor Docu-
ments folder and then choose File > Make Alias. The
Finder creates a file named “PrintMonitor Documents
alias” in the System Folder.

7. On the local Macintosh (i.e., the Macintosh that you
are printing from), open the Chooser and then select
PSPrinter and a destination printer. Print jobs will not
print to the printer you selected in this step, but PS-
Printer requires that you select one.

8. Select On for Background Printing and then select
AppleShare.

9. In the Select a File Server window, select the remote
Macintosh and then click OK.

10. Log into the remote Macintosh as Guest, select the re-
mote volume’s System Folder, click OK, then close the
Chooser. The System Folder icon will appear on the lo-
cal Macintosh desktop.

11. Copy the file named “PrintMonitor Documents alias”
from the remote hard disk’s System Folder to the local
hard disk’s System Folder.

12. In the System Folder on the local Macintosh, delete the
PrintMonitor Documents folder, then rename the Print-
Monitor Documents alias file to “PrintMonitor Docu-
ments”.

13. On the remote Macintosh, delete the PrintMonitor
Documents alias file.

Unexpected Results
W I N D O W S

Fonts Tab Dimmed in AdobePS 3.0.1 Setup


After selecting Setup in the AdobePS PostScript Printer
Driver 3.0.1 printer driver running in Windows 3.1x, the
Fonts tab is dimmed, preventing you from downloading
fonts and PostScript files to the printer by clicking the Font
Downloader button in the Fonts tab. Other tabs (e.g., Fea-
tures, PostScript) are available.


Enable TrueType fonts in the Fonts Control Panel:

1. Double-click the Control Panel icon in the Main Group
in Program Manager.

2. Double-click the Fonts icon.
3. Click TrueType.
4. Select Enable TrueType Fonts, click OK, then close the

Fonts Control Panel.
or: Launch the Font Downloader (WINDOWN.EXE) by
choosing the Run command in Program Manager:
1. In Program Manager, choose File > Run.
2. In the Run dialog box, type “C:\WINDOWS\SYSTEM-

\WINDOWN.EXE” in the Command Line text box, then
click OK.

 
Because the AdobePS PostScript Printer Driver 3.0.1’s Fonts
tab contains the TrueType font substitution options, the
Fonts tab is dimmed when TrueType fonts are not enabled
in the Fonts Control Panel. When TrueType fonts in the
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Fonts Control Panel are enabled, the AdobePS PostScript
Printer Driver 3.0.1’s Fonts tab is available.

Clicking Font Downloader in the Fonts tab or typing
“C:\WINDOWS\SYSTEM\WINDOWN.EXE in the Pro-
gram Manager’s Run dialog box launches WINDOW-
N.EXE, which enables you to download fonts and PostScript
files to a printer.

[PSPrinter, Unexpected Results, W, Issue/Solution, Medium, 2504]

Virtual Memory Information Omitted
on Installed Printer’s Test Page


After choosing to print a test page for an installed printer
using the AdobePS 4.1 printer driver, the test page lists no
virtual memory information. Other test page information
(e.g., printer name, driver name) prints as expected.


Reinstall the printer, then print a test page from the
AdobePS 4 Setup Utility, instead of from the printer’s Prop-
erties sheet:

1. Launch the AdobePS 4 Setup Utility by choosing Start
> Programs > AdobePS4 or by double-clicking Setup.exe
in the Drvrdisk folder in the Adobeps folder on the
PageMaker 6.01 Updater CD-ROM.

2. Follow the on-screen instructions to install the printer,
accepting the default name for the printer or type in
the preferred name, selecting Yes if you want this printer
to be the default printer for your Windows applications,
and selecting Yes to print a test page in the Add Printer
dialog box.

 
When you print a test page in Windows 95 by selecting Print
Test Page in the General pane of your installed printer’s
Properties window, the Windows 95 Printer Test Page,
which does not include the printer’s virtual memory infor-
mation, prints. When you print a test page by selecting Yes
to print a test page in the Add Printer dialog box in the
AdobePS 4 Setup Utility, the AdobePS 4 PostScript Printer
Driver Printer Test Page, which includes the printer’s vir-
tual memory information, prints.

The AdobePS 4.1 Readme.doc incorrectly states that
“You can get printer memory information by printing a
test page from the General properties dialog box.”

When you reinstall a printer, the installer creates a copy
of the installed printer’s icon, named “[Printer Name]
(Copy 1),” in the Printers Control Panel. After printing a
test page to your printer, you can delete the copy of the
installed printer by selecting the copy of the installed
printer’s icon, then pressing the Delete key.

[PSPrinter, Unexpected Results, W, Issue/Solution, Medium, 2505]
Font Menus in Windows 95 List
Fonts Removed from ATM


After you remove fonts in Adobe Type Manager (ATM) 3.0x
in Windows 95, application font menus continue to list the
removed fonts. The AdobePS 4.1 printer driver is installed
and set as the default printer.


Upgrade to ATM 4.0.
or: With no other applications running, add or remove
fonts in Ares FontMinder 3.0.5.
or: Temporarily remove any font in ATM, rename the
Psfonts folder, then launch Wordpad:
1. Remove a font (e.g., Anna) from the ATM Control Panel,

then exit ATM.
2. Rename the Psfonts folder (e.g., Psfontss).
3. Choose Start > Programs > Accessories > WordPad.
4. Quit WordPad.
5. Rename the Psfonts directory to its original name (i.e.,

Psfonts).
6. Readd the font you removed in step 1.
7. Restart Windows 95.
or: Update the font list using the AdobePS 4.1 Update Soft
Fonts option:
1. Make sure the fonts have been removed in the ATM

Control Panel.
2. Rename the Psfonts folder (e.g., Psfontss).
3. Choose Start > Settings > Printers to open the Printers

Control Panel.
4. Right-click on any printer that uses the AdobePS 4.1 printer

driver, then choose Properties from the pop-up menu.
5. In the Fonts pane of the Properties dialog box, click the

Update Soft Fonts button.
6. Click OK to close the Printers Control Panel.
7. Choose Start > Programs > Accessories > WordPad.
8. Quit WordPad.
9. Rename the Psfonts directory to its original name (i.e.,

Psfonts).
10. Restart Windows 95.
or: Edit the Windows 95 Registry to remove PostScript font
references:
1. Choose Start > Run, then type “regedit” in the Open

textbox and click OK.
2. Make a backup copy of the Registry by choosing Regis-

try > Export Registry File.
3. In the Export Registry File dialog box, choose a loca-

tion and name for the backup file, then click Save.
4. Open the Hkey_Local_Machine \Software\Microsoft\-

Windows\CurrentVersion\PostscriptFonts key (i.e., di-
rectory).

5. Select all the Postscript font values (i.e., files) and press
the Delete key to remove them. Do not remove the De-
fault value or SerialNumber value.

6. Exit the Registry Editor, which saves your changes to
the Registry, then restart Windows 95.
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When the AdobePS 4.1 printer driver is set as the default
printer and you add fonts in ATM 3.0x, references to the
fonts are added to the Atm.ini file, the Windows 95 Regis-
try, and Windows 95 MFD files. When you remove fonts in
ATM 3.0x, the font references are updated only in the
Atm.ini file, causing the removed fonts to continue to dis-
play in font menus.

ATM 4.0 removes font references from the Registry,
causing fonts to display in font menus as expected.

FontMinder 3.0.5 removes the PostScriptFonts key from
the Registry when you add or remove a font. When the incor-
rect font references are removed with the PostScriptFonts key,
font menus display fonts as expected. FontMinder must be
the only application running when you add or remove a font.

When you remove a font or use the AdobePS 4.1 Up-
date Soft Fonts option, then change the name of the Psfonts
folder and launch WordPad, the font references should be
updated so only the installed ATM fonts display in font
menus. If the font references do not update, you must re-
move the font values from the Registry manually.

Removing or editing MFD files does not cause font
menus to display correctly.

[PSPrinter, Unexpected Results, W, Issue/Solution, Medium, 5500]

LaserJet 4MPlus Uses Upper Paper Cassette
Instead of Lower with AdobePS 2.1.1


When you print to an HP LaserJet 4MPlus using the Adobe-
PS 2.1.1 printer driver with the Upper Cassette option se-
lected in the printer’s Paper options, the printer uses paper
from the Lower Cassette.


Print using AdobePS 2.1.2 or later.
or: Print using another printer driver (e.g., Microsoft
PostScript 3.58 printer driver).
or: Print to another printer (e.g., HP LaserJet 4M).

 
The AdobePS 2.1.1 printer driver causes the HP LaserJet
4MPlus to use paper from the Lower Cassette when the
Upper Cassette option is selected in the Paper pane of the
printer’s properties dialog box. Using AdobePS 2.1.2 or later,
another printer driver, or another printer enables you to
print from the Upper Cassette as expected.

[PSPrinter, Unexpected Results, W, Issue/Solution, Medium, 6274]

PostScript Print Options Missing in
FreeHand When Using AdobePS 4.1


When you print using the Adobe PostScript printer driver
4.1 (AdobePS), some options (e.g., Separations, Compos-
ite) are missing in the Macromedia FreeHand 5.0 Print dia-
log box.

Print using the Microsoft Windows PostScript printer
driver.
or: Use Macromedia FreeHand 5.0b or later.

 
Macromedia FreeHand 5.0 displays all options in the Print
dialog box when you print using the Microsoft PostScript
printer driver. Macromedia FreeHand 5.0b displays all op-
tions in the Print dialog box when you print using either
the AdobePS 4.1 or the Microsoft printer driver.

M A C  O S

Characters Appear Clipped in PDFs
from PageMaker and QuarkXPress


Text characters formatted with a TrueType font appear
clipped or do not display in a Portable Document Format
(PDF) file. The PDF file was distilled from a PostScript file
created by an application that generates its own PostScript
code (e.g. Adobe PageMaker, QuarkXpress) using the Adobe
PSPrinter 8.2.1 or earlier printer driver.


Print the PostScript file to disk using the PSPrinter 8.3 or
later printer driver.
or: Print the PostScript file to disk using the Apple Laser-
Writer 8.0 or later printer driver.
or: Use PostScript fonts instead of TrueType fonts.
or: Print the PostScript file to disk using an application
that does not generate its own PostScript code (e.g., Mi-
crosoft Word, WordPerfect, ClarisWorks).

 
The Adobe PSPrinter 8.2.1 or earlier printer driver returns
a random value for TrueType font bounding boxes when
converting TrueType fonts to PostScript. When you print a
PostScript file to disk from an application that generates its
own PostScript code, the driver provides the application
with incorrect font bounding box values. Because Acrobat
Distillerrequires font bounding box information when dis-
tilling PostScript files, it cannot generate PDF characters
correctly, causing them to appear clipped or not to display.

Other printer drivers (e.g., PSPrinter 8.3 or later, Laser-
Writer 8.0 or later) return accurate values for TrueType font
bounding boxes, enabling the converted characters to be
distilled correctly by Distiller. Printing from an application
that does not generate its own PostScript code enables
PSPrinter 8.2.1 or earlier to generate the PostScript code
itself, preventing it from returning random values for
TrueType font bounding boxes.
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Application Errors
W I N D O W S

Error “PS_ENUM.DLL version is
incompatible with AdobePS” When
Printing or Opening Application


After launching an application (e.g., Adobe PageMaker,
WordPad), choosing File > Print, or selecting a printer, the
error “PS_ENUM.DLL version is incompatible with Adobe-
PS version. Exit Windows and re-install the printer.” ap-
pears. Both Adobe Illustrator 4.x and the AdobePS Post-
Script Printer Driver 3.0.1 are installed.


Remove then reinstall the AdobePS PostScript Printer
Driver 3.0.1.

 
Because the AdobePS PostScript Printer Driver 3.0.1 re-
quires both the PS_ENUM.DLL file (modified 5/5/95) and
RUN_ENUM.EXE file (modified 5/5/95) to print, the
AdobePS PostScript Printer Driver 3.0.1 returns the error
“PS_ENUM.DLL version is incompatible with AdobePS
version. Exit Windows and re-install the printer.” after you
launch an application, choose the Print command, or se-
lect a printer when a different version of the PS_ENU-
M.DLL file or RUN_ENUM.EXE file is installed.

The AdobePS PostScript Printer Driver 3.0.1installs both
the PS_ENUM.DLL file (modified 5/5/95) and RUN_EN-
UM.EXE file (modified 5/5/95), overwriting existing PS_E-
NUM.DLL and RUN_ENUM.EXE files.

When installing Illustrator 4.x after installing the Adobe-
PS PostScript Printer Driver 3.0.1, clicking Yes in Illustrator’s
message that asks whether you want to overwrite the exist-
ing C:\WINDOWS\SYSTEM\PS_ENUM.DLL or C:\WIN-
DOWS\SYSTEM\RUN_ENUM.EXE file instructs Illustra-
tor to replace the existing PS_ENUM.DLL or RUN_E-
NUM.EXE file with the PS_ENUM.DLL or RUN_EN-
UM.EXE file included with Illustrator 4.x.

[PSPrinter, Application Errors, W, Issue/Solution, Medium, 2493]

Alert “...may not be compatible with watermark
or page layout” Printing with AdobePS 3.0.1


When printing a document using the AdobePS 3.0.1 printer
driver’s watermark or page layout (n-up) feature, the fol-
lowing alert appears: “This application may or may not be
compatible with the watermark [or page layout (N-up)]
feature you selected in Printer Setup. You may cancel the
job or try to print it.”

Print the document from an application that supports
AdobePS 3.0.1’s watermark or page layout feature (e.g.,
Microsoft Word).

 
When you print a document from an application that does
not support the watermark or page layout feature, the
AdobePS 3.0.1 printer driver displays the alert “This appli-
cation may or may not be compatible with the watermark
[or page layout (N-up)] feature you selected in Printer
Setup. You may cancel the job or try to print it.”

[PSPrinter, Application Errors, W, Issue/Solution, Medium, 2497]

Error “Not enough memory available for
this task” Changing Settings in AdobePS


When you change settings (e.g., paper orientation) in the
AdobePS PostScript printer driver 3.0.1 and earlier Setup
dialog box, the driver returns the error “Not enough mem-
ory available for this task. Quit one or more applications to
increase available memory, and then try again.” The driver
is connected to a printer port whose reference in the [Ports]
section of the Win.ini file does not have a colon following
it (e.g., LPT1.DOS)


Add a colon to the printer port reference in the [Ports]
section of the Win.ini file (e.g., LPT1.DOS:):

1. Open the Win.ini file in a text-editor that can save in
text-only format (e.g., Windows Write, Notepad).

2. In the [Ports] section, add a colon to the appropriate
printer port reference.

3. Save the Win.ini file in text-only format.

 
When AdobePS is unable to locate a colon following a
printer port reference in the [Ports] section of the Win.ini
file, it returns the error “Not enough memory available for
this task. Quit one or more applications to increase avail-
able memory, and then try again.” Adding a colon enables
you to set up the driver without error.

M A C  O S

Error “Printer could not be opened” When
Using Downloader 5.0.1 or Earlier


The error “Printer could not be opened.” appears when
downloading a font using Adobe Downloader 5.0.1 or ear-
lier in System 7.x.
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Use Downloader 5.0.4 or later.
or: When using Downloader 5.0.1, move the printer driver
(e.g., Apple LaserWriter, Adobe PSPrinter) from the Exten-
sions folder in the System Folder into the System Folder,
then download the fonts. After downloading the fonts, move
the printer driver back into the Extensions folder.

 
Downloader 5.0.1 and earlier return the error “Printer could
not be opened.” while downloading a font when the printer
driver is installed in the Extensions folder.

Downloader 5.0.1 and earlier searches for printer driv-
ers in the System Folder when downloading fonts, and can-
not locate printer drivers installed in the Extensions folder.
Downloader 5.0.1 and earlier are designed to run in Sys-
tem 6.x. In System 6.x, printer drivers are installed in the
System Folder. In System 7.0 and later, printer drivers are
installed in the Extensions folder in the System Folder.

Downloader 5.0.4 is designed to run in System 7.0 and
later, and can locate printer drivers installed in the Exten-
sions folder.

[PSPrinter, Application Errors, M, Issue/Solution, Medium, 6233]

PostScript Error Downloading PostScript
Level 1 File to PostScript Level 1 Printer


When you download a PostScript file saved as Level 1 Com-
patible to a PostScript Level 1 printer, a PostScript error
occurs (e.g., “syntaxerror; OffendingCommand: nostring-
val”). The printer driver you used to print the PostScript
file to disk is set up with a PostScript Printer Description
(PPD) file for a PostScript Level 2 printer (e.g., Apple
LaserWriter Pro 810, Apple LaserWriter Pro 810f).


Download the file to a PostScript Level 2 printer.
or: Set up the printer driver with a different PostScript Level
2 PPD file (e.g., HP LaserJet 4M) in the Chooser.
or: Set up the printer driver with a Level 1 PPD file or ge-
neric PPD file (i.e., click Use Generic) in the Chooser.

 
When you print a PostScript file to disk using a printer
driver set up with a PostScript Level 2 PPD file, you can
select the Level 1 Compatible option or the Level 2 Only
option in the Format dialog box, which appears after you
click Save in the Print dialog box. When you select the Level
1 Compatible option, some PostScript Level 2 PPD files
(e.g., Apple LaserWriter Pro 810, Apple LaserWriter Pro
810f) cause the printer driver to generate PostScript Level
2 code, instead of PostScript Level 1 code as expected. Be-
cause a PostScript Level 1 printer cannot interpret the Level
2 code, a PostScript error occurs when you download the
file to a PostScript Level 1 printer.
Using a different PostScript Level 2 PPD file (e.g., HP
LaserJet 4M), a Level 1 PPD file, or a generic PPD file en-
ables the printer driver to write the PostScript file with Level
1 code only, but may limit your printing options (e.g., pa-
per size, feed options).

To determine the PostScript Level of a PPD file:
1. Open the PPD file in a text editor (e.g., SimpleText,

Microsoft Word).
2. Locate the “*Language Level:” line, which indicates the

PostScript level of the PPD file. For example:
*LanguageLevel: “1”

System Errors
M A C  O S

System Error (e.g. , Freeze) After Clicking
Setup for Birmy PowerRip in PSPrinter


After you click Setup in the Chooser to set up a Birmy
PowerRIP 3.1f35 or earlier raster image processor using the
Adobe PostScript printer driver 8.3 (PSPrinter), a system
error (e.g., freeze) occurs.


Use the Birmy PowerRIP 3.1f36 or later raster image pro-
cessor.
or: Use another printer driver (e.g., PSPrinter 8.2.x or ear-
lier, Apple LaserWriter 8.x).

 
Because PSPrinter 8.3 is incompatible with the Birmy
PowerRIP 3.1f35 and earlier

 raster image processor, the system returns an error (e.g.,
freezes) after you click Setup in the Chooser to set up the
PowerRIP raster image processor using PSPrinter 8.3. Us-
ing the Birmy PowerRIP 3.1f36 or later raster image pro-
cessor or another printer driver enables you to set up the
PowerRIP printer in the printer driver without causing the
system to return an error.

The PowerRIP for the Macintosh and Windows is a soft-
ware raster image processor that uses Adobe PostScript
Level 2. When the PowerRIP application is running, the
Chooser lists the PowerRIP as an available printer after you
select a PostScript printer driver.
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Printing Problems
W I N D O W S

TrueType Font Character Strokes Print
with White Spaces with AdobePS 4.1


When you print text formatted with a TrueType font using
the Adobe PostScript Printer Driver (AdobePS) 4.1 Post-
Script printer driver, characters print with gaps (i.e., white
spaces) at the intersection of one or more character strokes.
For example, the number 8 prints with a white spot or line
at the point where the upper and lower circles of the char-
acter should meet. Text formatted with a PostScript font
prints as expected.


Format the text with a PostScript font.

 
When PostScript character strokes overlap, they create a
knock-out effect, causing a white space to appear where
they overlap. Because of this knockout effect, PostScript
fonts do not contain overlapping character strokes and print
as expected. However, TrueType fonts contain overlapping
character strokes. The AdobePS 4.1 PostScript printer driver
converts TrueType font information to PostScript informa-
tion, causing the TrueType font’s overlapping character
strokes to knockout when printed.

M A C  O S

Bold Text Prints as Random Characters
Using PSPrinter 8.0 or LaserWriter 8.0


Text formatted with a PostScript font and a bold type style
prints as random characters using the Adobe PSPrinter 8.0
or Apple LaserWriter 8.0 printer driver. Text formatted in
the same font but without the bold style prints as expected.


Install the PostScript outline (printer) font for the bold type
style (e.g., TrajaBol).
or: Do not apply the bold type style to the text.
or: Print the text using the PSPrinter 8.1.1 or later or
LaserWriter 8.1.1 or later printer driver.

 
When you apply a bold type style to text formatted with a
PostScript font, but the outline font for the bold type style
(e.g., TrajaBol) is not installed, the font should print in the
roman typeface (e.g., Trajan Regular). The PSPrinter 8.0
and LaserWriter 8.0 printer drivers, however, print random
characters instead of the roman typeface.

The PSPrinter 8.1.1 or later and LaserWriter 8.1.1 or
later printer drivers print the font in the roman style when
the outline font for the bold style is not installed.

[PSPrinter, Printing Problems, M, Issue/Solution, Medium, 2486]

Cannot Print to LaserWriter Select 310 Using
PSPrinter or LaserWriter Printer Driver


When you select the PSPrinter, LaserWriter 8.x, or Laser-
Writer printer driver in the Chooser, the LaserWriter Select
310 does not display in the Select a PostScript Printer list.


Select the LW Select 310 printer driver in the Chooser.

 
The LaserWriter Select 310 uses a serial port and requires a
modified LaserWriter 7.x printer driver for serial commu-
nication. All other PostScript printers use an AppleTalk port,
and can be targeted in the Chooser using the PSPrinter,
LaserWriter 8.x, or LaserWriter printer driver, which are
AppleTalk printer drivers.

Because the Apple LaserWriter Select 310 uses a modi-
fied version of the LaserWriter 7.x printer driver, applica-
tions that require the PSPrinter 8.x or LaserWriter 8.x
printer driver (e.g., PageMaker 5.0x or later) may not print
as expected to the LW Select 310.

[PSPrinter, Printing Problems, M, Issue/Solution, Medium, 2489]

Text Formatted in Font with
Long Name Doesn’t Print


When printing using the Adobe PSPrinter 8.0x and Apple
LaserWriter 8.0 printer driver, text prints as a blank area or
no output is received. The text is formatted with a font
whose name contains 32 or more characters (e.g., Helvetica
Condensed Black Oblique, Futura Condensed Extra Bold
Oblique, ITC Garamond Condensed Ultra Italic).


Print using the Adobe PSPrinter 8.1 or later printer driver.
or: Print using the Apple LaserWriter 8.1 or later printer
driver.

 
The PSPrinter 8.1 or later printer driver, and the LaserWriter
8.1 or later printer driver, support printing fonts whose
names contain 32 or more characters. The PSPrinter 8.0x
and the LaserWriter 8.0 printer drivers limit the length of
font names they can print, which causes missing text or no
output when printing fonts whose names contain 32 or
more characters (e.g., Helvetica Condensed Black Oblique,
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Futura Condensed Extra Bold Oblique, ITC Garamond
Condensed Ultra Italic).

Installation Issues
W I N D O W S

No Printer Icon Appears in Printers Folder
After Installing PSPrinter 3.0.1 in Windows 95


After you install the AdobePS 3.0.1 PostScript printer driver
in Windows 95, an icon for the selected printer does not
appear in the Printers folder.


Restart Windows 95.
or: Install AdobePS 4.1 or later, or the Microsoft PostScript
printer driver 4.0 or later.

 
Because the AdobePS 3.0.1 printer driver is not Windows
95 logo-compliant, it does not update the Windows 95 Reg-
istry during installation so that an icon for the selected
printer appears in the Printers folder. Instead, it adds en-
tries to the WIN.INI file. Windows 95 reads the WIN.INI
file when it restarts and incorporates the entries into the
Registry, creating an icon for the installed printer in the
Printers folder.

When you install a Windows 95 logo-compliant printer
driver (e.g., AdobePS 4.1 or later), it updates the Windows
95 Registry, causing an icon for the selected printer to ap-
pear in the Printers folder.

The AdobePS PostScript 3.01 printer driver is a 16-bit
application specifically designed for 16-bit versions of
Microsoft Windows (e.g., Windows 3.1, Windows for Work-
groups). AdobePS 3.0.1 is compatible with Microsoft Win-
dows 95, a 32-bit operating system, but is not Windows 95
logo-compliant. Windows 95 logo-compliant programs
meet the required Windows 95 Logo criteria, which include
support of system level features (e.g., long filenames, 32-
bit addressing, new user interface shell) and additional func-
tionality (e.g., OLE 2.0).

[PSPrinter, Installation Issues, W, Issue/Solution, Medium, 4132]

Error “Attempt to install an older version”
When Installing AdobePS 4.1


When you install a printer using the Adobe PostScript
printer driver (AdobePS) 4.1 setup utility from a CD-ROM,
the setup utility returns the error, “Error: Attempt to in-
stall an older version. Setup has detected that you are try-
ing to install one or more files that are older than what you
already have installed on your system. This operation is not
permitted.”


AdobePS 4.1.1 is installed.


Rename the Adobeps4.drv file in the Windows\System di-
rectory, then reinstall AdobePS.
or: Install a printer using the AdobePS 4.1.1 setup utility.

 
After you install AdobePS 4.x, you can run the AdobePS
setup utility from your hard drive (if you installed it there)
or from a CD-ROM. When you run the setup utility from
the hard drive, it automatically uses the installed version of
AdobePS (i.e., the installed version of the Adobeps.drv file)
to install a printer. When you install AdobePS 4.1.1 and
then install a printer using the AdobePS 4.1 setup utility
from a CD-ROM, the setup utility returns the error, “Er-
ror: Attempt to install an older version,” because it cannot
replace AdobePS 4.1.1’s newer Adobeps.drv file with Adobe-
PS 4.1’s older Adobeps.drv file. Renaming the previously
installed Adobeps4.drv file (i.e., the one installed for Adobe-
PS 4.1.1) enables the setup utility to install AdobePS 4.1.

AdobePS 4.1 is included on the Adobe Type Manager
(ATM) Deluxe 4.0 CD-ROM, while AdobePS 4.1.1 is in-
cluded on the PageMaker 6.5 CD-ROM. The Adobeps4.drv
file used by AdobePS 4.1.1 has a date of 05/24/96, while the
Adobeps4.drv file used by AdobePS 4.1 has a date of 03/01/
96. You can check the printer driver version in Windows 95
in an installed printer’s Properties dialog box by clicking
the Paper tab and then clicking About in the Properties dia-
log box.

[PSPrinter, Installation Issues, W, Issue/Solution, Medium, 4408]

Error “Invalid printer name” When
Installing Printer for AdobePS 4.x


When you install a printer with Adobe PostScript printer
driver (AdobePS) 4.x, the AdobePS Setup Utility returns
the error, “Invalid printer name [name].” The printer is
connected via a Novell Netware 4.x network using Netware
Directory Services (NDS).


Install the printer driver as a local printer using the
AdobePS Setup Utility, then set up the printer as a net-
work printer:

1. Using the AdobePS 4 Setup Utility, install the printer as
a local printer. For instructions, see document 370411.

2. Choose Start > Settings > Printers.
3. In the Printers Control Panel, right-click the newly installed

printer, then select Properties from the pop-up menu.
4. In the Properties dialog box, click the Details tab, then

click Add Port.
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5. In the Add Port dialog box, click Browse. Navigate to
the network printer, select it, then click OK. Click OK
again to return to the Properties dialog box.

6. Click OK to close the Properties dialog box.
or: Configure the path to a network printer so its pathname
does not contain a period. Consult your network adminis-
trator or the Netware documentation for assistance.
or: Disable NDS. Contact your network administrator or
the Netware documentation for assistance.

 
By default, NDS creates pathnames with periods (e.g., \\Press-
\.LP3-Vari2.courier) for networked printers. Because Adobe-
PS does not support pathnames with periods, the AdobePS
Setup Utility will return an error when you add a network
printer whose pathname contains a period. Disabling NDS,
creating pathnames without periods, or setting up the printer
as a local printer before setting it up as a network printer
enables you to add a printer without error.

[PSPrinter, Installation Issues, W, Issue/Solution, Medium, 5427]

Installing the AdobePS 2.1.2 Driver
from the Type On Call 4.0 CD-ROM

To install the Adobe PostScript printer driver 2.1.2 (Adobe-
PS) included on the Adobe Type On Call 4.0 CD-ROM in
Windows 3.1x:

1. Open the Printers Control Panel, then click Add.
2. Select the Install Unlisted or Updated Printer option

from the List of Printers, then click Install.
3. In the Install dialog box, type “X:\Free\PC\Adobe-

drv\Install,” where X is your CD-ROM drive, then click
OK. The Add Unlisted or Updated Printer dialog box
appears.
or: Click Browse, select your CD-ROM drive from the
Drives pop-up menu, select the Free\PC\Adobedrv\-
Install directory from the Directories list, then click OK.
Click OK again in the Install dialog box. The Add Un-
listed or Updated Printer dialog box appears.

4. In the Add Unlisted or Updated Printer dialog box, se-
lect the printer you want to install, click OK, then click
OK again.

5. Close the Printers Control Panel.
[PSPrinter, Installation Issues, W, Issue/Solution, Medium, 6050]

Password Requested When Installing
AdobePS 4.1 with Copstalk Installed


When you use the AdobePS 4 Setup Utility to install the
Adobe PostScript printer driver 4.1 (AdobePS) for a net-
work printer connected via a Copstalk 1.2 network, a dia-
log box appears requesting a user name and password, and
the installation fails.


Upgrade to Copstalk 2.0 or later.
or: Install the printer driver as a local printer using the
AdobePS 4 Setup Utility, then set up the printer as a net-
work printer:
1. Using the AdobePS 4 Setup Utility, install the printer as

a local printer. Select No when prompted to print a test
page.

2. Choose Start > Settings > Printers.
3. In the Printers Control Panel, right-click the newly installed

printer, then select Properties from the pop-up menu.
4. In the Properties dialog box, click the Details tab, then

click Add Port.
5. In the Add Port dialog box, click Browse. Navigate to

the network printer, select it, then click OK. Click OK
again to return to the Properties dialog box.

6. Click OK to close the Properties dialog box.

 
Because Copstalk 1.2 is not Windows 95 logo-compliant, it
does not support all Windows 95 network features. The
AdobePS 4 Setup Utility, which uses Windows 95 network
features to add a network printer, is unable to install a
printer on a Copstalk 1.2 network. You can use AdobePS
with a network printer on a Copstalk 1.2 network by first
installing the printer as a local printer, then setting up the
printer driver for the Copstalk 1.2 network.

Copstalk 2.0 or later is Windows 95 logo-compliant and
is compatible with the AdobePS 4 Setup Utility.

M A C  O S

Adobe Printer Driver 8.x for Macintosh:
Installation and Troubleshooting

This technical note covers how to install the Adobe Printer
Driver for Macintosh (represented by the PSPrinter 8.x
icon) and how to perform its troubleshooting procedures.
The contents of this technical note are:

 .    .
PSPrinter 8.x and LaserWriter 8.x are the same program.
Apple Computer, Inc. and Adobe Systems, Incorporated
wrote the program jointly, but use different distribution
channels for it. Therefore, the only differences are in the
representative icon and in the PPDs (PostScript Printer
Description files) that are distributed with the product.
Apple ships only Apple PPDs with LaserWriter 8.x and
Adobe ships PPDs from all manufacturers that have granted
Adobe permission to do so.

Aldus Corporation, Frame Technologies, and other soft-
ware manufacturers have also decided to distribute the
driver with their products. All companies distributing the
product have agreed to support their own distribution. For
example, if your copy of LaserWriter 8.x comes with Page-
Maker 5.0, then Aldus Corporation provides support. If you
purchased PSPrinter directly from Adobe, then Adobe pro-
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vides support. Support for specific features enabled by PPDs
are provided by the printer manufacturers.

 
How to install Adobe Printer Driver:

1. Quit all running applications, then insert Disk 1 into
the floppy disk drive. The Disk 1 window opens.

2. Double-click the Adobe PSPrinter Installer program
icon. The installer dialog box appears.

3. Click Install and the installation process begins.
The installer program copies the Adobe Printer Driver and
the Printer Descriptions folder (for PPD files) into the
System Folder as follows:

• For a Macintosh running System 7.x software, the in-
staller places these files in the Extensions folder inside
the System Folder.

• For a Macintosh running System 6.x software, the in-
staller places these files in the System Folder, along with
new versions of the Backgrounder, PrintMonitor, La-
serWriter, and Laser-Prep utilities.


This section describes some problems you may face during
and after installation, and how to solve them.

     
One of the features of PSPrinter 8.x is speed. In order to
print faster, PSPrinter 8.x spools the print job to the startup
hard drive. This spooling process then allows the driver to
convert the file to PostScript code, compress it for speed of
transmission, and then send it to the printer. If there is not
enough disk space to spool the file to the hard drive, then
the job may fail, resulting in a Disk Full error. If a print job
has failed because you do not have enough storage on your
startup hard drive, clear space on the drive by removing
files, then try your print job again. You may also wish to
return to version 7.x of the LaserWriter driver.

 
To Another Local Hard Drive This section provides work-
arounds for inadequate space on your startup drive to al-
low PSPrinter to create spool files. If you cannot remove
files to create additional space on your startup drive, try
one of these workarounds or use LaserWriter version 7.1.2.

If you have an additional hard drive attached to your
Macintosh, and are using System 7 or greater, you can force
PSPrinter to spool the printer file to that drive. However,
this works only in Foreground Printing mode.

You select Foreground or Background printing mode
in the Chooser when you select the printer. Apple’s Print-
Monitor program controls Background Printing, which
requires that spooled files be placed in the PrintMonitor
Documents folder of the active System Folder. Therefore, with
Background Printing on, you must spool to your startup
disk’s System Folder or to a System Folder on a remote Mac-
intosh (see the next section). The PostScript printer driver
controls spooling during Foreground Printing.
To control how your computer spools its print jobs:
1. Select the disk that you wish to use for spooling and

create a new folder. PSPrinter 8.0 users must name this
folder “PSPrinter Temp Folder,” and LaserWriter 8.0
users must name it “LaserWriter Temp Folder.” If you
have version 8.1 or later of the driver, then name the
folder “Printing Temp Folder.”

2. Select the folder you just created and choose Make Alias
from the File menu.

3. Copy the alias into your Extensions folder (located in
your System Folder), and delete the string “alias” from
the file name.

4. Start the Chooser, select the Adobe PostScript printer
driver and click Background Printing Off.

5. Print as usual. The document prints in the foreground
after spooling to the disk on which you created the new
spooling folder.

 
To Another Macintosh on the Network If you have another
Macintosh computer on the same network as your com-
puter, you can use it for spooling documents. For this to
work, both computers must have the same version of
PSPrinter 8.x (or LaserWriter 8.x, or HPLaserJet 8.x), and
you must be running System 7.0 or higher in order to share
files between the two computer. In the following instruc-
tions, the Macintosh from which you are printing is the
“local” computer and the Macintosh that you are using for
spooling purposes is the “remote” computer.
1. On the remote computer, choose the Chooser from the

Apple menu. Select the Adobe PostScript printer driver,
then choose a destination printer. Background Printing
should be on.

2. On the remote computer, double-click the startup disk
and select the System Folder. Choose Sharing from the
File menu. Turn on Sharing for the System Folder and
all enclosed folders, and select “Everyone” for the “See
all folders,” “See files,” and “Make changes” options.

3. On the remote computer, open the System Folder. Se-
lect the PrintMonitor Documents folder, then choose
Make Alias from the File menu.

4. On the local computer, choose Chooser from the Apple
menu. Select the Adobe PostScript printer driver, choose
a destination printer, then turn on Background Print-
ing. Close the Chooser.

5. On the local computer, open the Chooser again and se-
lect the AppleShare icon. Log onto the remote com-
puter’s System Folder as “guest.” Copy the file, “Print-
Monitor Documents alias” from the remote computer’s
System Folder into the local computer’s System Folder.

6. Delete the local computer’s folder called “Print Moni-
tor Documents” and change the name of the file “Print-
Monitor Documents alias” to “PrintMonitor Docu-
ments.” (If you select the PrintMonitor Documents
folder, then choose Get Info from the File menu, you
will see that the original file of this alias resides in the
remote computer’s System Folder.)
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7. On the remote computer, delete the file “PrintMonitor
Documents alias.” You no longer need this file.

8. Now you may print your files as usual from the local
computer. Observe the spool dialog on the local com-
puter. Immediately after you print from the local com-
puter, a temporary spool file is created on the remote
computer in the “PrintMonitor Documents” folder. The
system on the remote computer will find the spooled
documents and print them.
Important notes on this procedure:

• Any error messages you receive from PrintMonitor show
up only on the remote computer.

• Some virus protection software flags this process as sus-
picious activity. You may get a message that you are at-
tempting to bypass the Resource Manager. This is ex-
pected behavior for this workaround.

• The remote computer must have all fonts that the print
jobs require because the local computer does not send
fonts to it. If the required fonts are not available on the
remote computer, font substitution may occur, and
Courier will be substituted.

   
Most PPDs, but not all, have two printable area dimensions
included within the file. Those PPDs which do not have two
dimensions included dim the Larger Print Area option, in
which case the largest print area is the default. Choosing the
Generic PPD will make the larger print area option avail-
able, although it is not necessary to have this option because
the PPD automatically selects the largest print area.

    
PSPrinter 8.0 does print the following fonts:

• Helvetica Condensed Black Oblique
• Futura Condensed Extra Bold Oblique
• ITC Garamond Condensed Ultra Italic

The problems associated with printing these fonts have been
fixed in PSPrinter 8.1.1. You should upgrade to the 8.1.1
driver if you wish to print using these fonts.

PSPrinter 8.0 does not print any font that has been styl-
ized through the Style menu if the specific outline font is
not available. For example, if you choose Bold from the
Style menu for text in the Futura type face, and the Futura
Bold outline font is not installed, then the job will not print.
PSPrinter 8.1.1. produces a bold version of the regular type-
face even if you have not installed the bold version of that
typeface on the system.

   
Type Align files print as Courier when printed with PSPrint-
er 8.x from within TypeAlign or when exported as PICT
files or as Cut-and-Paste via the Clipboard. Files exported
as EPS print but will not have a preview.

If you are experiencing problems printing from the Adobe
Type Align program with printer driver 8.0, 8.1, or 8.1.1, try
using Apple printer driver version 7.x. The 8.x series of the
printer driver is incompatible with Adobe Type Align.
     
Problems concerning specific features in PPDs are handled
by the original manufacturer. One example of a PPD issue
would be the Larger Print Area being dimmed, as discussed
earlier in this technical note.

Updated PPDs and PPDs not distributed with PSPrinter
8.x should be obtained from the printer manufacturer.

[PSPrinter, Installation Issues, M, Issue/Solution, Medium, 4492]

Error “Please insert the disk PSPrinter”
When Installing PSPrinter 8.3.1


When you install the Adobe PostScript printer driver
(PSPrinter) 8.3.1, the Installer returns the error “Please in-
sert the disk PSPrinter” followed by the error “An error oc-
curred while installing on the active startup disk [disk
name]. Installation was not able to be completed, but your
original software has been restored.” Renaming the disk does
not enable the Installer to recognize it.


You downloaded PSPrinter from the Adobe World Wide
Web site or the Adobe BBS and then copied it to a disk.


Name the disk “PSPrinter” and make sure it contains only
the following files and folder:

Name Size Kind
Chooser 54K desk accessory
Installer 152K application program

Printer Descriptions folder:
PSPrinter 708K Chooser extension
PSPrinter Instal 168K Installer document
PSPrinter ReadMe 13K Simple text document

Additional Information When you download the Psp831-
.sit file and decompress it, it creates the following files and
folder:

• 8.3.1 User Guide.pdf
• PSPrinter folder
• ReadMe First

If you copy PSPrinter onto a disk to install it, you must
copy the contents of the PSPrinter folder only, then name
the disk “PSPrinter.” If the disk is not named “PSPrinter”
or contains unexpected contents (e.g., the PSPrinter folder
instead of only the contents of that folder), the PSPrinter
Installer returns the error “Please insert the disk PSPrinter.”
The ReadMe First file includes the following installation in-
structions:
“PSPrinter is systems software and, as such, cannot be in-
stalled to the same disk on which it resides. Copy the con-
tents of the PSPrinter folder onto a diskette. When creating
the diskette, please ensure to name on the disk appears ex-
actly as it does on the decompressed folder, paying special
attention to capitalization.”

[PSPrinter, Installation Issues, M, Issue/Solution, Medium, 4634]




